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1. Introduction 

Introduction 
 
ArtCAM Pro allows complex Reliefs (ArtCAM 3D models) to be created quickly and easily 
from 2D vectors (ArtCAM Wireframe) or bitmaps (Image files). These vectors and 
bitmaps can be generated within ArtCAM or imported from other systems. ArtCAM can 
also import 3D Surface data, which is translated on entry or after as a Relief model. 
 
ArtCAM Pro contains tools for editing the reliefs and combining stored reliefs. Once a 2D 
model or a 3D relief has been created, toolpaths can be generated to machine it. Multiple 
toolpaths are easily generated for roughing, finishing and engraving. The toolpaths can then 
be simulated to allow complete visualisation of the product before actual machining. 
 

Starting ArtCAM Pro 

• Double click the ArtCAM icon  on the desktop screen with the left 
mouse button. 

 

 
 
 
The ArtCAM start up screen appears as shown above. To start working in ArtCAM the user 
must create a New Model or for more complex assemblies, a New Project. Projects will be 
covered later at a more advanced stage of the training course. 
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• Select Create New Model.  
 

 
A New Model must have:  

• A defined area in Y and X to work in;  
• An origin (datum) position; 
• A resolution (the total number of squares within the working area). Each square 

defined by the resolution will either, stay put or extrude up or down to produce a tiny 
part of the 3D Relief form.  

 
When working with bitmaps the resolution is inherited from the imported image file, as a 
result it is important to use as higher quality image as possible. 
 
Resolution 
 
The dragon model shows the 2D view of the model broken up into a number of squares 
(pixels). Each square is given a height in ArtCAM dependent upon the command used. The 
first relief uses a low resolution, which means a loss of fine detail in the resulting 3D Relief.  

 
If a high resolution is applied, the model is broken into more pixels, which is in turn reflected 
in the definition and quality of the Relief model. 

 
  
 
 
 
 
Note: The trade-off with having a high 
resolution can normally result in larger file 
sizes, calculation and machine cutting times. 
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• Set the Height and Width as 100 with origin in the centre. 
• Ensure the units are set to mm and the resolution as 796 x 796 points. 
• Select OK. 
 

 
 
 
ArtCAM opens up displaying the 2D view, with the Relief displayed in the 3D View. You 
can toggle the views by selecting  (or F2 or F3 shortcut key).   
 
 
The 2D view is traditionally used for designing vectors (2D artwork) and bitmaps (images). 
Reliefs (3D models) created or generated from these entities can be viewed in 3D. 
  
Promoting a more efficient design process, ArtCAM 2010 now also allows direct modelling 
from vectors and bitmaps all within the 3D environment. This will be illustrated within 
forthcoming exercises.   
 
 
The following pages will summarise the key areas and available functionality within the 
default 2D and 3D environments.  
 
ArtCAM commands are accessed from the drop down Menu Bar options or directly from 
their respective Toolbars. 
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2D View Summary. 
 
The following summarises the key 2D view area and functions (default settings). 
 
 
 

 
 
 
 
 

 Zoom In > Zoom in the 2D view. 
 

 Zoom Out > Zoom out the 2D view. 
 

 Zoom Previous > Zoom to the previous view. 
 

 Zoom 1:1 > Zoom to 1 image pixel = 1 screen pixel. 
 

 Window Fit > Fit the artwork in the view. 
 

 Zoom objects > Zoom to fit the selected object(s). 
 

 Preview Relief layer > Show a colour preview of 3D Relief in the 2D view. 
 

 Bitmap Transparency > Adjust transparency of Bitmap in the 2D view. 

Model / Material 
(White region only) 

Main Pull Down Menu 

Default Toolbars 

Project Panel 

Coordinates Colour Palette 

2D View Toolbar 

Default Flyout Panels 

Project Tree 
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3D View Summary. 
 
The following summarises the key 3D view area and functions (default settings). 
 
 
 

 
 
 
 

 Isometric View. 
 

 View along the X axis. 
 

 View along the Y axis. 
 

 View along the Z axis. 
 

 Zoom In. 
 

 Zoom Out. 
 

 Zoom to previous view. 

Relief / Material 
(Gold region only) 

Zoom Tools 

Origin 

3D View Toolbar 

View Tools 
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 Scale view to fit. 
 

 Objects to draw (view) dialogue box. 
 

 Control various 3D graphics options. 
 

 Toggle Z zero plane. 
 

 Toggle drawing of the origin. 
 

 Toggle visibility of root assembly (in project)  
 

 Toggles between displaying flat and rotary reliefs. 
 

 Toggles visibility of the defined material block. 
 

 Toggles visibility of the simulation block (from machining). 
 

 Toggles colour shading (bitmap) 
 

 Toggle display of the front relief. 
 

 Toggle display of the back relief. 
 

 Toggle relief gradient analysis tool. 
 

Main Menu Bar 
 
At the top of the Main window, there is a Pull Down Menu Bar. 
 

 
 
 
Clicking on a menu item opens a pull-down menu that contains submenus and commands. If a 
menu item does not apply to the currently active view it will be greyed out.  
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Sub menus are indicated and selected via the arrow  at the right hand side (where 
applicable).  
 
For example, the File menu expands to show the following. 
 

 
 
A yellow bar highlights the function over which the mouse cursor passes. Left mouse button 
then activates the function. 
 
On certain commands, the keyboard shortcut is listed next to the description. For example, the 
shortcut to create a new model would be to press the CTRL key and then the letter N. 

Toolbars 
 
The default toolbars are summarised below.  
The left hand side of the ArtCAM interface is occupied by a Toolbar. This is the Design 
Tools Toolbar and contains four key design areas. 

 
 
Selection Tools 
This section contains tools that change the vector mode, such as the default select 
function, the Node Editing and the Transform function. 
 
Bitmap Tools 
This section contains the most common tools for painting and working with colours. 
Items such as paint brush, flood fill and pick colours are located here. 
 
Vector Tools 
This section contains all the main vector drawing tools. Available are the creation of 
Polylines, Squares, circles, ellipses, stars, polygons, arcs and text. 
 
 
 
 
Sculpting Tools 
This section contains all the available relief sculpting tools. These can be described as 
free form tools used for smoothing, smudging, depositing, carving, erasing and 
transferring.  
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File Toolbar 
 

 
 
Contains the standard Windows functionality including the Help reference and Options 
settings. 
 
 

 New Model/New Project > Creates a new blank ArtCAM Model or Project (flyout). 
 

 Open > Open an existing ArtCAM file or image (.art, .bmp, .tif, .gif, .jpg, .rlf (relief)). 
 

 Save > Save the current ArtCAM model or Project. 
 

 Cut > Move the currently selected object to the clipboard. 
 

 Copy > Copy the currently selected object to the clipboard. 
 

 Paste > Paste the currently selected object into the model. 
 

 Undo > Undo the last command 
 

 Redo > Redo the last Undo command 
 

 ArtCAM Notes > Add written notes to the current ArtCAM file. 
 

 Help > Launch ArtCAM’s online help.  
 

 Options > Change global settings for ArtCAM. 
 

Model Toolbar 

 
 
Includes tools to modify the Model size, resolution, Origin, Position and Lighting 
(shading). 
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Vector Creation  

 
 
Advanced creation tools for vectors including Offset, Bitmap to vector and Nesting. 
 

Relief Creation 
 

 
 
Tools to create Reliefs including Shape Editor, Weave wizard and Paste relief from a file. 
 

Relief Editing 
 

 
 
Tools to edit a current relief such as Scale, Smooth, Invert, Mirror and Offset. 

Vector Editing 
 

 
 
Tools to edit current vectors such as Vector doctor, Wrap vectors, Clipping, and 
Mirroring. 
 

Flyout menus 
 

Several icons have a small arrow    located at the bottom right hand corner.  
This indicates that this icon has further hidden functions which can be accessed from a flyout. 
 
Select and hold the left mouse button over an icon (with the arrow) will reveal the functions 
in the flyout menu. Releasing the mouse over the desired function will activate it. 
 
 
 
For example selecting the Circle icon from the Design Tools 
Toolbar reveals the ellipse. 
 
 
Selecting Draw reveals the Paint and Paint selective functions. 
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Project Panel 
 
The right hand side of the ArtCAM interface is occupied by the Project Panel and several 
Flyout panels. 

 
 

 
 
The Project Panel serves as a central area to manage the main design 
and machining aspects of the ArtCAM model.  
When an item is highlighted, the lower half of the panel displays 
further information.  
 
 
 

 
A summary is provided below. 
 

   Summarises the Model information. 
 

   Displays the Vector layers Toolbar. 
 

   Displays the Bitmap layers Toolbar. 
 

   Displays the Front Relief layer Toolbar. 
 

   Displays the Back Relief layer Toolbar. 
 

   Access to all 2D and 3D Toolpath functions. 
 
 
Right mouse selecting on an item in the Project Panel reveals the equivalent functionality 
(summarised above). 
 
 
For example, Right mouse selecting the Vectors option reveals all the 
Vector Layers functionality. 
 
 
 
 
The functionality above will be discussed in greater detail throughout the training course.  
 
Note: Although the Project panel provides a central area, all individual functionality shown 
above can also be accessed from either the top Pull down menu, or their specific toolbars.  
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Flyout Panels 
 
The four default hidden panels on the right hand side can be activated by simply holding the 
mouse cursor over the desired flyout tab. 
 

 
The Tool Settings Panel displays all the settings and information about 
the current or active function. 

For example, If the create circle function  is selected, The Tool 
settings Tab will reveal the Circle Creation form where required sizes and 
coordinates can be entered. Keyboard shortcut F6 also reveals this tab.  
 
 
 
The Toolbox Panel reveals external ArtCAM Plug ins (applications) that 
have been created and are compatible with ArtCAM. For Example, the 
Face Wizard can be found here. 
 
 
 
The Tutorials panel will provide a resource for Training materials and tutorials.  
 
 
 
 
New to 2010, The Live Panel will provide access to an online database of 
Training videos. This area is subject to live updates and additional videos 
released by Delcam. Note: Internet access is required to obtain this 
resource. 

 
 
 

Fly out Panels can be fixed (stay out) by selecting the Pin icon  
at the top right hand corner of the panel. 
 

Reselecting the Pin will hide the panel.  
 
Selecting the cross  will close and remove the panel tab from the screen. 
 
 
 
The following section will outline the ability of ArtCAM 2010 to customise the interface 
including adding and removing toolbars, functions and Fly out panels. 
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Interface customisation 
 
Right mouse selecting in the toolbars or grey border region will present the following 
menu. 
 
 

 
  

The top half of this menu lists all the standard 
 toolbars available in ArtCAM. Items indicated by the 

Tick,  are currently visible. Selecting or unselecting 
 the option will toggle its visibility from the interface. 
  
 
  
 
 
 
 
 

The lower half of this menu lists all standard Fly out 
 Panels available in ArtCAM.  

As above, selecting/unselecting the  will toggle its  
visibility. 

 
 If a Panel was closed  previously, it can be 
 reactivated here. 
 
 
 
 

Selecting Customise will present a new menu which 
allows extensive customisation of the layout. This is  
 outlined below. 

 
 

 All Commands are listed here. These can be 
dragged and dropped into existing visible toolbars. 
  

 Toggles Toolbar visibility and ability to create a 
new customised Toolbar. 

 
 Keyboard shortcuts can be assigned here. 

 
 Options to customise menu including animation. 

 
 General Toolbar options including Tool tips and 

icon size. 
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Docking Toolbars 
 
Toolbars can be dragged into the interface and allowed to ‘float’ in a desired location. 
 
At the end or top of each toolbar there is a dotted line.  
 
 
 

When the mouse cursor is placed over this line, it changes to a cross  at which point the 
toolbar can be selected and dragged. 
 
 
Double Mouse clicking in the top margin area of the Toolbar 
returns it to the original fixed location. 
 
 
 
 
 
 

Docking Fly out Panels 
 

When a Fly out Panel is fixed,  it also can be dragged (to float) or docked in a fixed 
position at each end of the screen. 
 
 
Select and Hold the mouse cursor in the top margin 
to drag the Panel into the screen.  
 
 
Whilst dragging, the interface displays a cursor pad in the centre and edges of the page. 
Depending on which arrow the panel is moved over, the screen will display a blue region 
where the panel will dock. Release the mouse button to dock the panel in this location.   
 
Panels can also be docked onto the top or bottom half of other fixed Panels. This is achieved 
by dragging a panel (as described above) onto another Panel to activate the ‘cursor pad’. 
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Themes and Layout 
 

From the top Window  drop down menu, a number of interface options are 
available. 
 
From Window > Theme….. 
 
Select Classic to change the colour scheme from the current 2010 theme a traditional 
ArtCAM background. 
 
 

 
 
From Window > Reset Layout…… 
 

 
 
 
Select ArtCAM 2010 to quickly reset the interface to default settings. 
 
Select ArtCAM 2010 Advanced to change the interface to an advanced setting where all 
toolbars are switched off. 
 
Select Classic to change the interface back to ArtCAM 2009. 
 
 

ArtCAM Help 
 
By selecting Help > Index from the top Menu bar (or by pressing the F1 shortcut key) a Help 
Page will open over the graphics area. 
 
 

 
 
Further sources of information and help can be 
obtained from the ArtCAM website and dedicated 
Forum.  
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Individual function forms can be expanded to provide a detailed explanation of each available 
option/entry. 
 
This is achieved by selecting the Help icon  in the top right hand corner of the active 

form. The example below applies to the Rectangle creation function.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ArtCAM File structure 
 

ArtCAM Models (*.art)  
 
An ArtCAM Model will contain all entities created within the session such as Bitmaps 
(image files), Vectors (2D geometry) Reliefs (3D models) and Machining data (Toolpaths). 
This ArtCAM file is identifiable by having an .art extension and can be saved or exported as 
a whole. 
 
It is also possible to save/export independent entity types from within the ArtCAM Model. 
These include the Vectors (mainly .eps .dxf .dgk .pic formats), Reliefs (.rlf), Triangle 
Models (.stl .dmt) and Machining Output (.tap). 
 
For more advanced applications where it is required to create an assembled group of separate 
Relief models (.rlf), an ArtCAM Project is first opened in which several ArtCAM Models 
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can be created and combined as required for an assembled item. When saved, the Artcam 
Project is identifiable by a .3dp extension. To enable the Reliefs to co-exist together, the 
individual components are converted within the Assembly as Triangle Mesh models. 
ArtCAM can also import surface models (e.g. iges) directly into an assembly. 

ArtCAM Projects (*.3DP)  
 
To allow greater freedom and complex 3D design, ArtCAM adopts a unique process of model 
making, where by all associated files or components are created and stored within a single 
Project folder (* 3DP). The Project folder can be best described as a repository for all the 

finished components or Assemblies.  Each Assembly within this Project Folder can then 
be freely positioned, combined and manipulated (e.g. shaded, scaled) in 3D space. 
 
 

Assemblies  
 

Each of these Assemblies  is created from ArtCAM model or imported as a triangular 
mesh replica (*.3da, *.stl, *.obj, *.dmt) or alternatively imported directly as a surface 
model (all major 3D modeling formats including *iges, *3dm, *dgk). 
 
Providing that a replica mesh has been created from an ArtCAM model stored as part of the 
same project, it also hosts a link to the ArtCAM model file from which it originates. 

A single assembly hosts any number of replica meshes and/or gems or further assemblies 
along with their own associated replica meshes and gems. You can create a relief layer in an 
open ArtCAM model directly from a replica mesh, or an assembly providing that it has an 
associated replica mesh. 

Assemblies are useful for a number of reasons. Firstly they are very useful for visualization, 
as they allow you to view both the front and back surfaces of a piece simultaneously. In 
addition, they can be replicated, scaled, positioned and rotated. Although an assembly can be 
manipulated in three-dimensional space, you cannot edit the actual shape of the assembly 
itself. 
 
The main advantage of using this system of creating and storing is that it allows assembly of 
separate components. For example, gems, settings and a ring shank can be created separately 
but then assembled in the Project Folder to create a finished piece. This finished piece can 
then be machined as a whole using the powerful Multi-Sided Machining Wizard. 
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Design 
 
ArtCAM Reliefs (*.rlf) or simply the 3D models are created from 2D vectors or bitmaps. 
These vectors (2D artwork) and bitmaps (images) can be generated within ArtCAM or 
imported from other systems. ArtCAM can generate reliefs from an imported model.  
When dealing with bitmaps and Reliefs it is important to understanding Resolution, which 
will influence the overall surface detail of the relief and ultimately the final piece. 
 
 

Manufacture 
 
The final stage for most ArtCAM Projects is to manufacture the 3D relief as a real object. 
Currently there are two major routes to production: via CNC machining or Rapid 
Prototyping. ArtCAM can realise its models using either method. 
 
ArtCAM can calculate the toolpaths required to machine the individual relief or final 
assembly. The calculated toolpaths can be then sent directly to the machine (via post-
processing) ready for cutting. 
 
Most Rapid Prototyping machines require a specific type of 3D model. These models are 
made up of a small triangular mesh, which defines its whole surface shape. This type of file is 
commonly known as an STL, file format. ArtCAM allows you to export the final assembly 
or relief in the STL format, ready for manufacture. 
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Mouse buttons application 
 
Each of the three mouse buttons performs a different operation in ArtCAM Pro 3D View 
(F3). By using the ALT, Ctrl or Shift key on your keyboard, these operations can be 
extended as the following details explain. 
 
 
 
 
Left mouse button: Picking and selecting 
 

 
This button is used for selecting items off the main pull down 
menus, inputting data and selecting parts of the model. 
 
 
 
 
 
 

 
 
 
Middle mouse button or wheel: Dynamics 
 
 

 
Zooming: 
 
Scroll the middle mouse to Zoom IN/OUT of the model. This applies 
to the 2D and 3D view. Alternatively, Select the SPACE BAR and 
Right mouse button together and move the mouse to Zoom IN/OUT. 
This option applies to the 3D view only) 
 
Panning: 
 
Hold down the Left and Right mouse buttons and                                      
move the mouse, to move the view across the component. 

 
                                     Rotating/Twiddle:  
 
                                     Hold down the middle button/wheel and move the 

 mouse. Alternatively Select the SPACE BAR and Left mouse      
button together and move the mouse. This option applies to the 3D 
view only) 
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2. Generating Vectors 

Overview 
 
Vectors are mathematically defined shapes consisting of a series of points (nodes), which are 
connected by lines, arcs or curves (spans) to form the overall shape.  
 
They can be: 
 

• Generated directly within ArtCAM by using the Vector Tools in the Assistant page; 
• Rectangles, Squares, Circles, Polylines, Ellipses, Polygons, Stars or Text that can 

be edited if necessary to generate the final vectors to create a Relief from; 
• Imported from another drawing package, using the File – Import menu option, or 

copied and pasted from another package using the standard Windows commands. 

Mobile Phone Cover Exercise 
 
In the following exercise you will generate a Mobile Phone Cover using the Vector Tools.  
Below is a drawing of the item including basic dimensions, so that you can get an idea of how 
the final product should look before working through the ‘step by step’ instructions. 
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• Select New Model.  
• Enter a Height of 150mm, a Width of 80mm. 
• Set the Origin to the centre of the model and a resolution of 
approximately 628x1178 points (by moving the slider).  
 
 

 
 

 
• A new ArtCAM Model (sheet) is generated based on the parameters 
defined above. 
 
 
The vector creation tools (any many others) can be accessed in a number of ways. 
 
 

1. The default Design Tools toolbar on the left hand side. 
 
 
 
 
 
 
 

2. Activate the Assistant Tab by right mouse selecting in the 
grey border. 

 
 
 

3. Right mouse select in the white model sheet and select 
the Drawing options. 
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• Using a method outlined above, Select Create Rectangle.  
 
• The Rectangle creation form appears in the Tool settings form. 
 

 
• Enter a Width of 50mm, a Height of 120mm, Corner Radii of 3mm and a 
Centre Point of X 0 and Y 0. 
• Select Preview to view the proposed shape (represented as dashed lines) 
 

 
 
• To create the shape, single left mouse click in the view area. 
 
The rectangle is created on the model page whilst keeping the rectangular creation form open. 
This can be utilised to create a new rectangular shape. 
 
Note: A single right-mouse click would create the shape, but close the vector creation form. 
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The outer shape of the phone cover is created. 
 
 
 
 
 
• In the Rectangle Creation form, change the Width to 40mm, Height to 
30mm, Corner Radii to 1mm and the Centre Point to X0 and Y20. 
• To create the shape, single right mouse click in the view area (and close 
the form) 
 
 
 
 

This second Rectangle will represent the display window.  
 
 
 
 
 
 
 
 

• Select Create Ellipse.  
• Enter a Start Point of X –14 Y –50 with a Height of 7mm, Width of 10mm 
and an Angle of 140 degrees.  
 
 
• Right mouse click to create the shape. 
 

 
 
 
 
A block pattern of this single Ellipse can be created quickly to complete 
the keypad. 
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• With the Ellipse selected, click on the Block Copy / Rotate  icon from 
the Vector Tools area on the Assistant’s page or top of the screen. 

 
 

 
 
 
 
The Block and Rotate Copy allows you to create a 
block copy in X and Y or a rotated copy around a 
point. 
 
The distances can be set as an offset value or by a 
gap value between each item. 
 
 
 
 
 
 
 
 
 

 
 
• Select Block Copy and Distances are offsets options. 
• Select an X Offset of 14mm, with Number of Columns as 3. 
• Select a Y Offset of 10mm, with Number of Rows as 4. 
• Select Apply. 
 

 
 
 
 
 
 
 
The keypad is created.  
 
A centre ‘menu’ button will be created from two combined 
circles. 
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• Select Create Circle.  
 
 

 
 
 
• Create a circle with centre at X0 Y–4, radius as 4mm.  
• Create a second circle or radius 4mm but with centre at X0 Y–8. 
 
 
 

 
 
 
 
The Circles will now be ‘merged’ into one. 
 
 
 
 

 
 
 
 

• Select both circles and select the Weld button  from the Position, 
Combine, and Trim Vectors area on the Assistant’s page. 
 
 
By welding the two Circle vectors, a new single vector is created. 
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Note: The Weld command only works on two selected 
closed vectors. 
 
 
 

 
• Zoom in to see the vector more clearly. 
 

Zoom either using the  tool or middle mouse cursor.  

• With the new vector selected, select Node Editing.  
• Hover the mouse over a left black node, press the right mouse button 
and from the side menu select Smooth Point (or press S on the keyboard). 

 
 
• Repeat for the other side to provide a shape with smooth inner corners. 
• Press N to return to Select mode and click away from the vector. 
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• Select Create Polygon.  
 
 

 
 

 
• Enter No. of Sides to be 3, Angle 0, Polygon Centre at X –14, Y –2 with 
a Radius of 4mm. 
 
• Create the triangle shape (left/right mouse click) 
 
 
 

 
 
 
 
 

• With the Triangle vector selected, select Offset Vector(s).  
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• Select an Offset Distance of 1mm, Offset Direction as Outwards and 
Offset Corners as Radiused. 
 
• Select Offset to create the new shape. 
 
 
 

 
 
The new vector is Radiused at the corners. 
 
 
 

 
 
• Select the original inner vector and press Delete on the keyboard. 

• Select the new vector and select Mirror Vectors.  
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The Mirror Vectors page allows you to mirror 
the selected vectors about themselves or about 
a selected line. 
 
 
 
 
Note: You must select the mirror line first 
before applying the Mirror Vectors - About 
Line option.  
 
 
 
 
 
 
 
 

 
 
• Select  Copy the Original Vectors (Ctrl),  

• Select Bottom  to create the mirrored triangle. 
 
 

 
 
 
The new vector will be moved downwards. It can be nudged using 
the down arrow or moved more accurately by a value using the 
Transform Vectors command. 
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• Select Transform Vectors  (or hit T twice on the keyboard). 
 
 

 
 
• Enter Move Y as –1, select Apply.  

• Select both Triangular vectors and then select the Group button.   
 
     The two items can now be treated as one. 
 
 
A polyline will be created to use as a mirror line for this grouped feature.. 
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• Select Create Polyline.  
 
       

 
 
 
Polylines can be generated by entering absolute co-ordinates in the X and Y area, by angles 
and line length, as relative co-ordinates using the dx and dy (distance from last point) or by 
clicking with the cursor. 
 
Note: Polylines can also be created dynamically in the graphics area either by holding down 
the left mouse key while freehand sketching a curve, or by using the left mouse key to click 
individual points along the required route. 
 
• Select Add (enters a point at 0, 0). 
 
• Enter 30 in dy (30mm in Y direction), select Add and then Close. 
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• Select the Polyline first and then shift select the triangle group. 

• Select the Mirror button.  
• Select  Copy the Original Vector option. 
• Select About Line to create the mirrored feature. 
• Delete the Polyline. 
 

 
 

• Select Create Vector Text.  
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• Select Font as Arial, Script as Western and Size as 3mm. 
 
• Click at the bottom of the 2D View and type ARTCAM VECTOR TEXT. 
• Select Done. 
 
 
 

 
 
This Text can be wrapped around the outer 
vector, with the text inside, using the Wrap 
text round a curve option. 
 
 
 

 

• Select Wrap text round a curve.  
 

 
 
The Text on a Curve page appears, which 
allows you to align an existing Text Vector to a 
Curve Vector.  
 
 
Text Position includes options that control the 
relative, position of the text across the curve. 
 
Text on other side puts it on the other side of the 
curve. 
 
Text Alignment includes options that control the 
flow of the text along the curve. 
 
Text Spacing allows you to vary the spacing 
between the individual characters. 
 
 
 
Editing Style allows you to set individual 
Words or       Letters to be repositioned around 
the curve independently. 
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• Select the Text and shift select the outer vector and press Select in the 
Text on a Curve page. 
 
• Select the Text Position option as Specify and enter 1mm.  
 
 
• Tick the option Text on other side. (if text is on the outside) 
• Select the Editing style option as Single Words. 
• Dynamically Move the text using the cursor to align on the three sides 
as shown below. 
 
• Select OK 
 
 
 
 
 

The Text is now wrapped. 
 
 
 
 
 

• Select Create Polyline  and in the form select the option Draw 
smooth polylines.  
 
• Left mouse click 5 suitably positioned points to create a Smooth Polyline 
similar to the one shown below. 
 
 
 
 
 

You will use this Polyline to paste vectors along. 
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• From the Vector Tools area, select Create Stars.      
 
 

   
 
 
• Enter No. of Points as 5, Star Centre as X –28, Y 62, Radius of first 
Points as 4.5mm and Radius of second Points as 2mm. 
 
• Preview and create the star. 
 
• Select the Star vector and shift select the sketched Polyline. 
 

• From the Vector Tools area, select Paste along Curve.  
 
 

 
 
 
The vector is pasted incrementally along the curve either by dividing the curve equally 
(Specify Number), or by a fixed distance, leaving any surplus at the end of the curve 
(Specify Distance). 
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• Select Specify Number and enter Number of Copies as 5. 
• Select Paste. 
 
• Delete the original Star vector and the sketched Polyline. 
 

 
 
 
 
• Select File - Save As, browse: 
 
D:\users\training\COURSEWORK \ArtCAMPro-Jobs and enter as File name - 
training-phone-cover.  
 
• Select File - Close Model. 
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3. Vector Editing and Layers 

Vector Editing 
The following chapter will introduce several Vector Editing options. 

Shield Design Exercise 
 
• Create a New Model with a Height of 20mm, Width of 20mm and a 

resolution of approximately 1002 x 1002 points. 
• Set the Origin to the centre and select OK. 
 
Note: 

You can move the origin position by using the option Set Model Position.  
This allows you to position the zero datum to the Centre, one of the 4 corners or a typed 
coordinate position.  
 

Vector input by snapping to a Grid 
 
• From the top file menu, Select Bitmaps – Views - Snap Grid - Snap Grid 

Settings… 
 

 
 
Grids provide snap points to assist in dynamically 
defining vector points. They are available from the 
Bitmaps - Views pulldown menu. 
 
 
The selected grid spacing value is mainly dependent on the 
size and complexity of the component to be produced. 
 
 

• Set the Grid Spacing to 1 and select OK. 
 
• From the same top file menu, switch ON the options Snap to Grid and 

Draw Snap Grid. 
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A grid is displayed in the view, with an even point 
spacing of 1mm. 
 
 
 
 
 
 
 

 

• Select Create Polyline.  
 
• Snap to the same Grid points as shown in the image below. 
 
 

 
 
 
Note: The best position to Snap in a vector point is just to the 
lower, left of a Grid point. 
 
 
 
 
 
 

 
• Select File - Save As: 
     D:\users\training\COURSEWORK\ArtCAMPro-Jobs\train-shield. 
• Switch OFF both Snap to Grid and Draw Snap Grid. 
 

• Select Fillet vector with an arc.    
 
 
 
 
The Fillet is generated at a node point or from 
two Polylines that would intersect. 
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• Enter a Fillet Radius of 5mm and select line either side of the bottom 

point to generate the fillet. 
• Change the Fillet Radius to 1mm and create a Fillet at the top two 

corners. 
• Change the Fillet Radius to 2.5mm and create a Fillet at the bottom two 

corners. 
 

 
 
 
 
 
The main shield vector is as shown. 
 
 
 
 
 
 

 
• Close the form. 
 

• With the vector selected, select Offset Vector.   
• Set an Offset Distance of 0.5mm, select Inwards and Radiused. 
• Select Offset, followed by Close. 

Vector input by snapping to Guidelines 
 

 
You’ve created a constant Offset. For the middle part, instead of 
using Grid lines, Guidelines, you will input actual values. 
 
Guidelines are pulled from within the rulers located around the 
border of the model. For accurate positioning they can be 
snapped direct to Grid points or if the Grid is switched off once 
created they can be precisely positioned via a Position Guide 
form. 
 

• Hold the left mouse button down within the top ruler (as shown) and drag 
down a horizontal Guideline. 
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• Release the left mouse button, when it is near to the centre of 
the model.  

 
• Right mouse click on the Guideline to activate the position guide. 
 

 
This form allows the guideline to be accurately positioned, 
deleted or further guides to be inserted. 
 
 
• Enter a New Position of 0 and select Apply. 
 
• Repeat the process to generate a vertical 

Guideline at 0 (by dragging it from within the 
left ruler.)  

 
 

 
 
The two guidelines intersect at the origin. These guidelines 
can be snapped to, when creating or moving vectors or nodes. 
 
You can show or hide these Guidelines by clicking 
on the Guidelines icon in the top left corner of the 
rulers. 
 
 
 
 

• Select Create Polyline.   
• Snap on the Guidelines to create horizontal and vertical centrelines. 
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• Pick the top left corner icon in the 2D View to switch off Show 

Guidelines.  
 
 
The two new Polylines will be used to create Offset Copies by setting the on Both Sides 
(Ridge) option. 
 

• Offset  the horizontal Line vector both sides by 0.5mm selecting the 
Both Sides (Ridge) option. 

• Offset  the vertical Line vector both sides by 0.4mm. 
• Delete the original Polylines (if the Delete original vectors option was 

not set during the offset operations). 

• Select Trim vector to intersections  and trim the Polylines to fit 
within the shield. 

 
 
 
 
 
 
The completed vectors for the shield design are 
as shown.  
 
 
 
 
 
 
 
 
 

 
 
• Select File - Close Model (do not save) 
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Vector Layers 
 
Vector Layers provide a more ordered method of managing the selection and display of 
selected groups of vectors. In default mode ArtCAM Pro assigns all vectors produced to  
a layer named Default Layer (which cannot be renamed or deleted). Any additional Vector 
Layers can be Renamed, Deleted and Merged together. As new Layers are created specific 
group of vectors are assigned to them as required. The layers Tab also allows the user to 
Open (Import) and Save (Export) vector data. 
 
 
The Vector Layer Toolbar can be activated by right mouse 
selecting in the Grey border (Right hand side) and selecting 
Vector layers. 
 
 

 
 
 
Vector Layers are controlled by this toolbar. The default layer is highlighted and any 
generated or imported vectors will be displayed, providing the layer in switched on (light 
bulb). 

Phone Cover Exercise 
 
• Open the model training-phone-cover. art from 

D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
 
 
 
 
 
 
This exercise will show how to import vectors and also move or 
transfer existing vector data to other layers.  
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• Select the stars vector group. 

 
 
 
Layers need to be generated before vectors can be 
placed into them. It is good practise to give the 
layer a sensible name. 
 
 

 
 
 

•  Select New  on the Vector Layers toolbar.  
 

 
 
New Vector Layer 1 has been created. By double-clicking on the name itself, the name can 
be changed. 
 
• Double click on New Vector Layer 1, overwrite as stars and select Enter 

(or mouse click away from the name) to confirm.  
 

 
 

The new level is now named and switched on (denoted by the light bulb icon).  
 
• Right mouse click on the selected star vector group and select Move 

Vectors To… > stars.  
• Switch off the Layer stars by clicking the light bulb. 
 

 
 

 
 
 
The star vectors are now hidden. The other vectors on the default 
level are still displayed. 
 
Note: When a Layer is current (highlighted in colour) any vectors 
that are pasted are automatically placed on that layer. 
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• Create a new Layer and change the name to buttons. 
• Create a new Layer and change the name to holes. 
 

 
 
• Select the 12 Ellipse vectors. 
 

 
 
The selected vectors will be transferred to another Layer. 
 

Note: Layers can have the snapping facility  switched on or 
off. For example if you had vectors close together and wanted to 
be sure you snapped to the correct vector on a layers, then you 
would switch snap off for all the other layers. 
 
 

 
• Right mouse click on the selected button vector group and select Move 

Vectors to…..> buttons.  
• Select the other shaped vectors as shown. 

 
 
 
 
These selected vectors will be placed on another Layer. 
 

Note: Layers can be locked,  so any vectors on that layer 

cannot be moved or edited until the layer is unlocked.  
 

 
 
 
 
• Right mouse click on the selected vector group and 

pick Move Vectors to….. > holes.  
 
 

• Switch off the Default Layer,  leaving on the layers 

buttons and holes.  
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The vectors displayed are going to be combined into the one current layer Merged Layer 1. 
 

• Select Merge Visible.  
 

 
A new Layer called Merged Layer 1 has been 
created with the visible data combined. The vectors 
on the layers can be coloured for identification. 
 
 

 
 

• Select the black circle  to the left of the 
Layer name Merged Layer 1. 

 
 
The colour form appears. This allows you to select the 
colour for the vectors on that layer.  
 
 
 
• Select any suitable colour and then OK. 
 
• Switch on all the Layers using the Toggle All Visibility. 

 
• Select Open  from the Vector layers toolbar. 
 
• From ArtCAM Data, select the file tel-insert.eps and 

select Open. 
 
 
The vectors are imported as a group on a new layer (same as 
filename), so to use them individually, they need to be ungrouped. 
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Vectors can also be imported from the main menu by first highlighting the required vectors 
and then selecting Vectors > Import…. from the top menu. 
 

 
 
Similarly, vectors can also be exported by selecting the desired vectors and then selecting 
Vectors > Export…. from the top menu. 
 

 
 

Selecting  from the Vector layers toolbar, will export all vectors on that layer. 
 
 
 
• Select File > Save. 
• Select File > Close Model. 
 

Node Editing 
 
The structure and appearance of a vector can be changed using the Node editing options. 
Vectors are made up of nodes and spans which are displayed only when ArtCAM switches to 

Node Editing Mode.  
 
 

Upon selecting a Vector, Node Editing can be entered by selecting  from the Design 
Tools Toolbar on the left hand side, the Right mouse select menu or simply selecting N on 
the keyboard. 
 
 

 
 
 

node 

Vector mode Node mode 

span 

control point 
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The following example illustrates the different options available for editing nodes, spans and 
control points within selected vectors. 
 

Enamel-Pin Exercise 
 
• Create a New Model with a Height of 20mm and Width of 60mm. (Origin 

in centre) 
• Create a Guideline at X 0 and Y 0. 
 

• Select Create Polyline.  

• Untick the Draw smooth polylines option.  
• Enter X as –25mm, Y as 1mm and select Add. 
• Enter dx as 35 and select Add. 
 

• Select Create Polyline.  
• Enter X as –25mm, Y as –1mm and select Add. 
• Enter dx as 35 and select Add.  
 
Note: Selecting the Spacebar will stop the Polyline creation at the last point. A new start 
point can then be created. 
 

You can join these two vectors 
together with either an arc, straight 
line or by moving the end points. 
 

 
• Select both vectors. 

• Select Join Vectors With A Curve.   
 
You’ve joined the two vectors 
together to make a new vector. 
You will close the open vector. 
 

• Select the new vector. 

• Select Close vector with a Line.  
 

The vector has been closed. You 
will now modify an Ellipse to 
produce a leaf shape. 
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• Select Create Ellipse.  
• Enter a Start Point of X -4mm Y 4mm, an Ellipse Height of 3mm and 

Width of 12mm with an Angle of 340 degrees. 
• Create the Ellipse shape (single mouse click on model sheet) 

• Select the Ellipse and then Select Node Editing.    
 
 
By pressing N on the keyboard on a selected vector, you will 
switch between Node Editing mode and Select Vectors mode. 
 
You will open up the Ellipse halfway by removing spans using 
the right mouse button menu. 
 

 
 
 
 
 
The part of the vector between two node points is called a 
span. If a span was removed, the vector will become 
open. 
 
In Node Editing mode, if you move your mouse over a 
node point and click the right mouse button a local set 
of menus appears. 
 
 
 
 

 
• Right mouse click over the right bottom span of the Ellipse and select 

Remove Span from the menu. (The span mode is indicated by ~) 
 
 
The Ellipse vector is opened at the required area. You’ll 
need to delete the other lower span. 
 
 
 

• Right mouse click over the left bottom span of the Ellipse and select 
Remove Span from menu. 

 
Only half of the original Ellipse remains. You will close 
this half Ellipse with a line in the Select Vectors mode. 
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• Select Select Vectors.  

• With the vector selected, select Close Vector with a Line.  
 

 
 
The vector is now closed. You will now create a 
Polyline to mirror the vector across. 
 
 
 
 

• Select Create Polyline.  
• Enter X as –10.3mm, Y as 1.5mm and select Add. 
• Enter X as 3.6mm, Y as 6.6mm and select Add. 

• Shift-Select the Polyline, the leaf shape and then Mirror Vectors.  

• Tick the Copy the Original Vectors option and select About Line.  
• Close the form.  

• Select the Polyline and select Cut.   
 

 
 
The leaf shape has been generated. This will now be 
mirrored to the other side. 
 
 

 

• Select Create Polyline.  
• Snapping to the horizontal Guideline, create a single line across the 

model. 
• Select the new horizontal vector and the leaf shapes. 

• Select Mirror Vectors.  

• Select Copy the Original Vectors and the About Line option.  
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• Select Create Circles.   
• Set the Circle Centre as X 10mm Y 0, select Radius and enter 1.5mm.  
• Deselect Create with arcs, before creating the circle. 
• Create a new Circle with Centre at X 16mm Y 0, and Radius of 6mm.  
• Select Create followed by Close. 
 

 
 
 
The smaller circle will be subtracted from the larger circle. 
 
 
 
 
 
 

• Select the larger circle and then shift select the smaller circle. 

• Select Subtract vectors.   

• Select Node mode.  
 

 
 
• Move the mouse over the top marked area 

and from the right mouse menu select insert 
a point. 

 
• Move the mouse over the bottom marked 

area and from the right mouse menu select 
insert a point. 
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The addition of these extra node points will allow you to 
move the node point in between the new points and it will 
only stretch the vector within that region.  
 
 
 
 
 

 
 
• Select the middle node. 
• Drag the point along the horizontal vector (towards the origin) and 

release the mouse at a suitable position as shown in the image below. 
• Delete the horizontal vector. 
 

 
 
 
 
 
The two control points can be dragged to produce a more 
realistic     curve. 
 
 
 
 
 

• Select each control point and move around as shown in the image below. 
 

 
 
 
 
The shape is complete. You’ll have to create another Polyline 
to build the inner part, using the smooth option. 
 
 
 
 
 
 
 

• Select Create Polyline.  
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• Tick the Draw smooth Polylines option. 
• Select several points on the model to make the shape roughly as shown. 

 
 
 
The last point is not smoothed when it is joined. You can 
smooth it in the Node Editing mode. 
 
When you are in the Node Editing mode the smooth point 
shows as blue and a non-smooth point shows as black. 
 
You can now Offset all of the vectors. 
  
 

 
• Click on the start point to complete a single closed vector.  
 

• Select Vectors.  
• Select all the vectors.  

• Select Offset Vectors.  
• Select an Offset Distance as 1mm, Offset Direction as Outwards/Right 

and Offset Corners as Radiused. 
• Select Offset, followed by Close. 

 
 
 
The design is complete.   
 
 
 
 

 
You can fill in the closed vectors with bitmap colour to give an idea of what the design will 
look like before the Relief is made. 
 
• With the new offset vector highlighted, select the gold coloured square 

from the palette at the bottom of the 2D View with the left mouse button. 

• Select Flood Fill Vectors.  
 
 
The whole inside of the vector is 
filled with the selected colour. 
(The colour is a bitmap). You can 
select other vectors and fill them 
in to overwrite the colour. 
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• Select the leaf and stalk vectors and select the green coloured square 

at the bottom of the 2D View.  

• Select Flood Fill Vectors.  
 
• Select the petal vectors and select the red coloured square at the 

bottom of the 2D View.  

• Select Flood Fill Vectors.  
 

 
 
If the vectors were altered, the colours 
need to be recreated. 
 
 
 

 
 
• Select File - Save As with the File name - train-flower in 

D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 

Selected Node Editing 
 
When a node is selected it turns red and can be moved dynamically. Shift and select allows 
the user to select several nodes in a curve, ctrl and select allows the user to pick individual 
nodes, to be moved simultaneously. 

 
 
 
 
 

 
 

 
 
 
 
 

 
Selecting X on the keyboard edits the selected points with the X coordinate of the last node.  
 
Selecting Y on the keyboard edits the selected points with the Y coordinate of the last node. 
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Vector Clipping and Slicing 
 

Vector Clipping  is used to trim a group of vectors within a defined vector. 

Vector Slicing  is used to split a vector across a selected cutting vector. 
 

Vector Clipping Exercise 
 
• Create the following vectors in a New Model of size 100 x 100 and Origin 

at the centre. 
 
 
 
 
The sizes do not really matter as long as there are a few stars 
within the pentagon. 
 
 
 
 

 

• Select Vector Clipping.  
 

 
 
The vector clipping form appears with instruction on how to use 
the command and the different results available with the options 
given. 
 
• Select the Polygon and then shift – select all of the 

other vectors (can drag a box). 
 
• Select Clipping Direction as Inside and 

Overlapping Vectors as Trim. 
 
• Select Clip Vectors. 
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The stars that are whole within the polygon are retained 
and those that cross the polygon are trimmed back as 
shown. 
 
 
 
 
 

 

Vector Slicing Exercise 
 
• In a New Model of size 100 x 100 and Origin at the centre sketch the 

following vectors. 
 

 
 
• Shift - Select both the closed vectors followed by the open (slicing) vector. 

• Select Slice Selected Vectors.  
 

 
 
 
 
 
 
The Vector Slice page appears displaying the options available. 
The Use last selected vector option is only available when 
more than one vector is selected. Otherwise it will be greyed 
out. 
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• Select the options Close and Use last selected vector. 
• Select Slice Vectors. 
• Nudge the two new vectors up and down using the keyboard up and 

down arrow keys to see the result. 
 

 
 
 
 
 
The vectors have been sliced and rejoined. 
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4. Generating a Relief 

Introduction 
 
A Relief is the ArtCAM 3D model created either from vectors, bitmaps, imported 
CAD surface models or existing stored Reliefs. One set of options operates by 
building a Relief from one or more closed vectors using the Shape Editor. Double 
clicking on the selected vector/s or pressing the F12 shortcut key will open the 
Shape Editor form. 
 
 
There are three main 3D forms: Domes, Pyramids and 
Flat Planes.  By selecting one of the 3D Relief icons 
the relevant options become active in the form. The 
Relief form can only occur within the defined model 
area and is effectively formed by the individual bitmap 
squares (Resolution) moving up or down in Z. The 
Shape Editor is the original method for creating a 
Relief. As ArtCAM has evolved, a selection of more 
specialised and advanced options have been added to 
the Relief Tools area of the Assistant. 
 
 
 
There are 6 options to control how the Relief is combined with the existing ArtCAM 
model. These comprise Add, Subtract, Merge High, Merge Low, Zero and Zero 
Rest. 
 
 
 

 
 
This 2D View shows the Dome Relief already made from a 
Circle vector and the Rectangle selected for the new 
Relief. 
 
 

 
This simple example will be used to help illustrate the result of using the 6 control options. 
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Add  
This method Adds the new Relief on 
top of the current Relief,  
producing the result as shown right. 
 
In this case a Plane of a Start Height  
of 1mm was added to the Relief. 

Subtract 
This method Removes the new Relief 
from the current Relief, giving the 
following effect. 
In this case a Plane of a Start Height 
of 1mm was subtracted from the  
Relief. 
 

Zero 
By applying Zero, the Relief inside the 
vector will have Z height of Zero. 
 
 

Merge High 
 
The new Relief is Merged along Z 
through the existing Relief.  
In this case a Plane of a Start Height of 
1mm has been Merged High through 
the  
Dome. 

Merge Low 
 
The new Relief is Merged through the 
existing Relief and any of the original 
model form above it is removed. 
In this case a Plane of a Start Height of 
1mm was Merged Low through the 
Dome. 
 

Zero Rest 
 
The new Relief is flattened to the 
Zero plane outside of the vector 
area. 
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Reliefs are displayed in the 3D View and can be Exported from ArtCAM as 
individual (.rlf) file. (to be discussed later) 
 
The smoothness of a Relief is dependant on the Resolution.  
 

Selecting Preview Relief layer  from the 2D view Toolbar, will display the 
Relief as a shaded image in the 2D view. 
 
 
Reliefs can be calculated from vectors from the 2D View or directly within the 3D 
View. 
 
The following examples show how to create a relief by selecting vectors within the 3D 
View. 

Anchor relief 
 

• Select Open Model.  
• Open the model anchor.art from: D:/users/training/ArtCAM Data. 
 

 
 
The vectors are displayed in the 2D view. 
 
• Select the 3D View tab or press F3.  
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The vectors are by default not displayed in the 3D view. 
 

• From the 3D View toolbar, select Toggle Vector Visibility.  
 
 
 
 
 
 
The vectors are displayed on the 3D View. 
 
 
 
 
 
 
 
 
 
 
• Double left mouse click on the vector 

shown below (indicated by the arrow) 
to raise the Shape Editor form. 

 
 
 
 
 
 
 
 
 
 
• Select a Flat Plane shape with a Start 

Height of 0.5mm.  
 
For a Flat Plane, The Start Height indicates the very top 
Z level. 
 
 
• Select Add on form to generate the shape. 
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• From the 3D view toolbar, Select Draw Zero Plane  to hide the Z 
zero plane 

 
 
 
 
The bar is produced as shown. If you place the 
mouse on the Relief, the Z height at that point 
(0.5mm) will be displayed in the information box 
at the lower right of the graphics area. 
 

 
 
 
 
 
• De-select the bar vector by selecting in empty space. 
 
 
 
 
• Hold down the shift key and select the 

two inner vectors as shown. 
 
                
A Relief will now be generated inside the two 
selected vectors.  
 
 
 
 
 
 
 
• Press F12 on the keyboard to raise the Shape 

Editor form. 
 
 
• Select a Dome shape with an Angle of 45 

degrees and No Limit with regard to overall 
height.  

 
• Set the Start Height at 0 and select Add. 
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A Dome shape of 45 degrees has been created 
within the selected vectors. The final height of 
the dome was dictated by the defined angle (as No 
limit was selected) 
 
By Selecting Add, the new relief ‘added’ to the 
bar relief below.  
 
 
 
 
 
 
The main body of the Anchor will now be created and merged into the current Relief. 
 
 
 
 
 
 
 
 
• Select the main anchor vector as 

shown highlighted. 
 
 
 
 
 
 
 
 
 
• Select a Pyramid shape with an Angle of 65 

degrees.  
 
• Select Limit to Height and Enter a Height 

value of 0.75 (mm). 
 
 
• Select Merge High. 
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The main anchor shape is created and 
merged with the bar relief. 
 
This shape was produced from the 
vectors extruding as a triangular shape 
of 65 degrees. As it reached a height of 
0.65mm, it ‘levelled off’. 
 
 
 
 
 
 
 
 
• Shift Select the two hook 

vectors as shown. 
 
 
 
 
 
 
 
 
 
 
 
• Select a dome shape with an Angle of 30 

degrees.  
 
• Enter a Start Height value of 0.75 (mm). 
 
 
• Select Merge High. 
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The ‘hook shapes’ have been created 
and merged with the main body. 
 
The Start Height provided a ‘platform’ of 
0.75mm before a dome shape of 30 
degrees was applied. 
 
 
 
 
 
 
 
 
 
 
 
• Shift Select the two Circle 

vectors as shown. 
 
 
 
 
 
 
 
 
 
 
 
• Select a dome shape with an Angle of 

65 degrees.  
 
• Enter a Start Height value of 0.5 (mm). 
 
• Select Merge High. 
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• From the 3D View toolbar, select Toggle Vector Visibility.  
 
 
 
 
 
The Vectors are hidden, and the final result 
can be seen. 
 
 
 
 
 
 
 
 
 
 
 
 
• Select File - Save As naming the model as training-anchor in: 
D:\users\Training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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Tin Lid relief 
 

• Select Open Model.  
 
• Locate and Open the model tintop.art from: D:\users\training\ArtCAM 

Data. 
 

 
 
 
• Activate the Bitmap Layers Fly out panel by Right 

mouse clicking in the graphics area border. 
 
 
• Select Toggle Bitmap layer Visibility  to 

switch off the Bitmap. 
 
 
 
 
• Select Toggle All Visibility from the Bitmaps layer menu. 
 
       
This switches off the bitmap so that any vectors can be seen more clearly and as a 
result will be easier to work with. 
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• Select the outer circle vector and press F12 to raise the Shape Editor 

form. 
 
 
 
• Select a Dome Shape of Angle 60 degrees 

with a Start Height of 5. 
 
• Limit to Height of 1mm. 
 
 
 
 
 
 
 
 
 
 
 
 
• Select Add to generate the Shape. 
 
 
 
 
 
 
• Select both of the leaf vectors. 
 
• Select a Dome shape with an Angle of -8 

degrees and a Start Height of 0.5mm. 
 
 
 
 
 
 
 
• Select Add from the Shape Editor form. 
 
(Note: A negative value and Add is the same as entering a 
positive value and selecting subtract) 
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• Select both of the leaf vein vectors and Enter 

Shape Editor. 
 
 
 
 
 
 
 
 
 
 
 
• Add a dome shape of 10 degrees. 
 
 
The subtle detail can be seen if zoomed in to that region. 
 
 
 
 
 
 
• Select the petal group to the left of the highest 

petal.  
 
 
 
 
 
 
 
 
 
 
 
• Enter a Dome shape of 15 degrees and Start 

Height of 6.5 degrees. 
 
• Select Scale to Height with a distance of 1mm  
 
 
• Select Merge High. 
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The Start Height value is the actual height from 
the Z0 of the Relief. By setting the value 
higher than the leaves, the petal forms are 
raised above. Using Merge High, the petals are 
blended into the surrounding Relief. 
 
 
 
 
 
 
 
 
• Select the other petal group to select 

the higher group.  
 
 
 
 
 
 
 
 
 
 
 
 
• Enter a Dome shape of 15 degrees and 

Start Height of 7 degrees. 
 
• Select Scale to Height with a distance of 

1mm  
 
 
• Select Merge High. 
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This petal group is higher than the other group 
(by 0.5mm), so that the petals in the front are 
full petals and the petals below are only partial 
petals. 
 
 
 
 
 
 
 
 
• Select the small circle vector (in the centre 

of the flower).  
 
• Merge High a Dome shape with an Angle 

of 25 degrees and a Start Height of 7mm. 
 
 
 
 
 
 
 
The centre of the flower has been merged into the 
petals. 
 
The text will be added next. 
 
 
 
 
 
 
 
 
• Select the ‘Sunflower’ and ‘Seeds’ text. 
 
• Select an Angle of 45 degrees and a Start 

Height of 6mm. 
 
• Set Limit to Height at 0.2mm 
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• Select Merge High from the Shape Editor form, followed by Close. 
 
 
 
 
The Text has been produced with a chamfered edge 
and a flat top making it stand out. 
 
The Relief can be shown in alternative shaded 
colours or the same as the original Bitmap. 
 
 
 
 
 
 
 
 
 

• From the Top Model Toolbar, Select Lights and Material .  
 
• Select the option 2D View under the Colour area. 
• Move the sliders to select the desired Shininess and Reflection Map. 
• Select Apply. 
• Close the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select File - Save As and enter a File name as train-tin-lid in: 

D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
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Envelope Relief Distortion 
 
 
In ArtCAM you can use a selected vector to distort the final Relief, allowing you to 
interactively shape the final Relief. 
 
• From the 2D view, select the outer circle vector. 

• Select Relief Envelope Distortion from the Relief Editing Toolbar.  
 

 
 
 
The selected vector is displayed within a special, gridded vector box (called the 
Envelope) with Nodes displayed at each corner. 
 
The Nodes can be manipulated with a view to ‘stretching’ and ‘squeezing’ the Relief.  
 
Additional Nodes and the Envelope vector can be edited by using normal vector commands. 
 
When a Relief is distorted, the Z height can be altered, if required or kept the same.  
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• From the right toolbar (or F6), select the Tool 

Settings to display the Relief 
     Envelope Distortion Toolbar. 
 
 
 
• Select the option Replace Original Relief. 
 
 
• Select Create Vector Outline and set Relief Z 

Height Scaling as Average Scale at 100% (a 
Rectangular vector appears as the outer limit). 

 
 

• Ensure the option  is 
selected. 

 
 
 
 
 
 
 
 
• Place the mouse in the middle of 

the top span, right mouse click 
and select Insert Node from the 
menu. 

 
 
 
 
 
 
 
• Select the new point and move it 

down in the Y until it is halfway 
down the text letter I. 
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• Move the left angle node down. 
 
 
• Select the right span across the 

top and press L to convert to a 
line. 

 
 
 
• Move the bottom left angle node 

until it snaps on the letter e. 
 
• Move the bottom right angle 

node until it snaps on the letter d. 
 
 
• Select Add from the Combine area of the form. 
• Select Paste to recreate the Relief and Finish to accept. 
• View in 3D. 
 
 

 
 
 

• Select Lights and Materials from the top toolbar.  
 
 
 
 

4.18 Issue ArtCAM Pro 2010 



ArtCAM                                              4. Generating a Relief 

 
 
 
 
• Set the options as shown. 
 
• Select Apply and then close the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• The Original relief has been 

distorted and replaced with 
the new relief. 

 
 
 
 
 
 
 
 
 
 
• Select File - Save As and a enter a File name as Tin Top in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs 
 
• Select File – Close Model. 
 
 
 

                                                                    Issue ArtCAM Pro 2010                                                              4.19 



4. Generating a Relief                                                                                                                ArtCAM  

 
Teddy Bear Relief 
 
This example takes the user through the creation of a Teddy bear Relief model mainly using 
the Shape Editor in addition to the specialised Angled plane and ISO-Form lettering Relief 
options.  
 
 

•  Select Open Model.  
 
• Browse to: D:\users\training\ArtCAM Data and select the model   

Teddy.art. 
 

• In the 3D View, Select Toggle Vector Visibility  to display the 
vectors. 

 
 

• Select View Along Z.  
 
 
 
• Select the body vector using the left mouse 

button.  
• Double click the selected vector to Enter 

Shape Editor. 
 
 
 
 
 
 
 
• Select a Dome shape, with an Angle of 45 

degrees with No Limit followed by Add 
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• Using the left mouse button, select the 

outer ears vectors, then hold down the Shift 
key and select the inner ears vectors.  

 
 
 
 
 
 
 
• From the Shape Editor form, select a Dome 

shape with No Limit, an Angle of 45 
degrees with a Start Height of 0.5mm 
followed by Add. 

 
 
 
 
• Select only the inner ear vectors. 
 
• Select a Flat Plane with a Start Height of 

0.5mm and select Merge High. 
 
 
 
The inner ears have merged with the outer edge.  
 
 
 
 
 
• Select the arm vectors. 
 
If the arms were added to the body, then a bulge would 
appear where the arm and body vectors overlap. 
  
Therefore, the arms need to be Merged High. 
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• Select a Dome shape, with an Angle of 45 

degrees with No Limit and select the Merge 
High button. 

 
 
 
 
 
 
 
 
 
 
 
 
• Select the face vector. 
 
 
 
 
 
 
 
 
• Select a Dome shape with an Angle of 60 

degrees with No Limit and select Merge 
High 

 
The face has merged into the current Relief. 
 
 
 
 
 
 
 
 
• Select the circle ‘stomach’ vector. 
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• Select a Dome shape of 15 degrees with a 

Start Height of 0, No limit followed by Add. 
 
• Close the Shape Editor form 
 
 
 
 
 
 
The Relief from the feet vectors will be generated using an 
angled plane. This will slope the feet at a specified angle 
making the toes point forwards and the heels lean back. 
 
 
• Select the feet vectors. 
 
 

• Select Create Angled Plane from the Relief Creation toolbar.  
 
 
 
 
 
This allows an angled plane to be generated from the 
heights of upto 3 points. 
A minimum of two points must be selected to generate an 
Angled Plane at a fixed angle to the XY axes.  
 
A maximum of three points for a plane aligned to a 
compound angle to the XYZ axes.  
 
After the points are selected, the Z heights can be edited 
in the form before the Relief is created.  
 
The final Relief is generated with Add, Subtract, Highest 
or Lowest (Merge) 
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• Tick the Set Third Point option to reveal the coordinate boxes. 
 
 

• With the Left mouse button, Drag and Drop the icon  under First 
Point on Plane to the bottom of the left foot as shown below. 

 
 

 
 
The X any Y coordinates are updated to reflect the selected position.  
 

• With the Left mouse button, Drag and Drop the icon  under Second 
Point on Plane to the top of the left foot as shown below. 

 
 

 
 
 
The X any Y coordinates are updated to reflect the selected position.  
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• With the Left mouse button, Drag and Drop the icon  under Third 
Point on Plane to the centre region of the ‘stomach’ as shown below. 

 
 

 
 
The X any Y coordinates are updated to reflect the selected position.  
 
 
The Z coordinates will now be entered to define the height of the Plane at these points  
 
 
 
 
 
• Enter the Z coordinates for the three 

points as highlighted. 
 
 
 
 
 
 
 
• Select Highest, followed by Create. 
 
 
 
 
 
 
 

• In the 3D View, Select Toggle Vector Visibility  to switch off the 
vectors. 
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The angled ‘feet’ are merged 
into the body. 
 
 
 
The final features will be added. 
 
 
 
 
 
 
 
 
 
• In the 2D view select the feet vectors 

only 
 
 
 
 
 
 
• In Shape Editor, Select a Dome shape with an 

Angle of 15 degrees, No Limit and select 
Add. 

 
 
 
 
 
 
 
• In the 2D view select the paw vectors 

group which also includes the ‘snout’. 
 
 
• In Shape Editor, Select a Dome shape with 

an Angle of 45 degrees, No Limit and 
select Add. 
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• In the 2D view, Select the eyes and nose 

vectors. 
 
• Select a Dome shape with an Angle of 45 

degrees, No Limit and select Add. 
 
• Select Close on the Shape Editor form to 

dismiss it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Lights and Materials from the top toolbar.  
 
 
 
 
 
 
• Select Brushed Silver in the 

Shading Setup area. 
 
 
 
• Close the form. 
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The Teddy will be completed by smoothing intersecting edges and creating text relief on the 
body 
 

• Select Smooth Relief  from the Relief Editing toolbar. 
 
 
 
 
 
• Select Whole Layer, enter the number of 

Smoothing Passes as 3 and select 
Apply. 

 
• Select Cancel to close the form. 
 
 
 
 
 
 
Sharp edges (such as arms to body) have been 
smoothed. 
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Constant Height Letters  
 

The Constant Height Letters  function provides a constant height set by the user, 
whereas text created using the Shape Editor can sometimes result in thin parts of the letters 
being lower than the rest of the Relief. 
 
 
Constant Height Lettering will be added to the teddy’s stomach region. 
 
 

• In the 2D View, Select Preview Relief Layer  to display the 
underlying Relief. 

 
 
 
 
 
The higher the Relief the lighter shade it appears.  
 
 
 
 

• Select Create Vector Text  from the Design Tools Toolbar. 
 
 
• If not already visible, activate the Tool Settings fly out 

Panel by Right mouse selecting in the grey border       
(or press F6). 

 
This reveals the Text Tool form 
 
 
 
 
• Set the Font as Times New Roman and a Size 

of 2mm. 
 
• Type the word TED and position as shown. 
 
• Select Done on the form to close it. 
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• With the Text highlighted, select Constant Height Letters  from the 
Relief Creation Toolbar. 

 
 
 
 
• Set a Top Height of 0.25mm and a Bottom 

Height of 0.25mm. 
 
 
• Select Circular Cross Section, followed by 

Add and OK to close the form. 
 
 
 
 
 
 
 
 
• View the final results in 3D. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
•  Select File – Save As. 
 
• Browse to: D:\users\training\COURSEWORK\ArtCAMPro-Jobs and   

enter the name as train-ted 
 
•  Select File – Close Model. 
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5. Pictures 

Introduction  
 
Coloured Pictures can be generated or edited within ArtCAM using the Bitmap toolbar or 
they can also be imported using any of the following formats bmp, .tif, .pcx, .gif, and .jpg.  
 
The coloured areas of a Picture can be used directly with the Shape Editor to create a Relief 
instead of using vectors. As with vectors the enclosed coloured area is formed of tiny 
squares, which are given a height. In this case the smoothness of the Relief is directly, 
dependant on the resolution of the picture. Where coloured areas are used the smoothness of 
the Relief is not improved by changing the model resolution, as the number of bitmap 
squares is inherent in the picture. 
ArtCAM can also generate vectors around a selected colour. The vectors can in turn be 
smoothed using such techniques as splining and Node Editing after which the actual model 
resolution is used to control the smoothness of the Relief. ArtCAM has the power to 
temporarily link colours together, which enables the user to combine different coloured areas, 
without changing the original picture. This is called Colour Linking. 
 

Colour linking - Spider Coin Exercise 
 
In this exercise a bitmap has already been opened, modified and saved as an ArtCAM model. 
 

• Select File > Open or  
• Load in the model train-spider.art from: D:\users\trainingArtCAM 

Data. 
 
 
 
 
The picture is made up of several colours, 
displayed at the bottom of the 2D View.  
 
Similar to vectors, you can assign each colour a 
shape.  Colours can be temporarily combined 
using Colour Linking. This is a temporary 
way of creating larger areas of similar colour 
that does not permanently change the 
original picture. 
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The Bitmap is loaded with the associated colours displayed on a palette at the bottom of the 
screen. 
 

 
 

• Single left mouse button click on the yellow square. 
 

Yellow has now been assigned as the primary colour.  
 

• Select the white square using the right mouse button.  
 

This is now assigned as the secondary colour.  
 

• From the top pull down menu, select Bitmaps > Colour > Link All 
Colours.  

 
This will temporarily change all colours to yellow (except the Secondary colour - white).  
This has reflected on the bitmap itself and indicated on the palette with smaller coloured icons 
and connected lines. The main area of the coin (yellow) can now be raised as one unit. 
 

 
 

• Double click with the left mouse button the yellow colour in the 2D 
View. 

• In the Shape Editor, select a Flat shape with a Height of 1.5mm, 
followed by Add. Select Close. 

 

 
 
 

The ‘coin’ shape has been generated. To produce the Rim, the colours need to be unlinked 
and then re-linked to include only the purple text. 
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• From the top pull down menu, select Bitmaps > Colour > Reset All 
Links.   

• Double right mouse click on the dark purple square  at the 
bottom of the 2D View. 

 
Double clicking with the right mouse button makes the colour become the secondary, and 
links it to the primary. So in this case the dark purple text becomes yellow. 
 
Primary 
 
Secondary 
 
 

• Switch to the 3D view and from the 3D view toolbar, toggle on Colour 

shade.  
 

 
The bitmap image is applied to the Relief. 
 
In addition to the colour palette, Reliefs can also be 
created from the colours selected directly from the 
Relief. 

 
 

• Double left mouse click on the yellow 
colour in the 3D View. 

 
 
• In the Shape Editor, select a Flat 

shape with a Height of 2mm, followed 
by Merge High. Select Close. 

 
• From the top menu, select Reset All Links. 

 
 
• Double left mouse click on the dark 

purple colour in the 2D View and the 
Shape Editor will display it. 

 
• In the Shape Editor, select a 

Pyramid shape with an Angle of –25 
degrees, Start Height of 0, followed 
by Add. Select Close. 
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• Toggle Colour shade  to switch OFF the bitmap. 
 

 
 
 
The raised rim edge and ‘V’ grooved 
text is clearly shown on the coin. 
 
 
 
 
 
 

• Double left mouse click on the dark green colour  in the palette. 
• In the Shape Editor, select a Dome shape with an Angle of –10 

degrees, Start Height of 0, followed by Add.  
• Select Close. 

 
 
 
 
The Relief now includes curved indentations 
between the web detail and the spider outline. 
You will now add the actual spider and web 
detail to the Relief. 
 
 
 
 
 
 
 
 
The following steps will apply a relief to the areas 
indicated by a number as shown. 
 
 
 
 
Note: The antenna is currently made up of two 
colours (light blue and purple). These colours will 
be combined (linked) so the area (3) can be treated 
as one. 
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• Toggle Colour shade  to switch ON the bitmap. 
 

• Double left mouse click on colour 1.  
• In the Shape Editor, select a Dome shape with an Angle of 24 

degrees, Start Height of 0, followed by Add. 
   
• Double left mouse click on the colour 2 in the 2D View. 
• In the Shape Editor, select a Dome shape with an Angle of 24 

degrees, Start Height of 0, followed by Add. Select Close. 
 
The black will be linked with the light blue to provide a single coloured area for the whole of 
the head. 
 

• Single left mouse click on the black area in the 2D View to assign as 
the primary. 

• Double right mouse click on the light blue square at the bottom of the 

2D View to link it to the primary black colour.  
• In the Shape Editor, select a Dome shape with a Start Height of 0, an 

Angle of 30 degrees, followed by Add. Select Close. 
• From the top menu bar, select Reset All Links. 

 
     Link the dark blue with the light blue, to make all of the antennae area have the same 

colour. 
 

• Single left mouse click on the dark blue area in the 2D View. 
• Double right mouse click on the light blue square at the bottom of the 

2D View. 
 
 
 
 
 
 
 
 
 
• In the Shape Editor, select a Dome shape 

with an Angle of 45 degrees, Start Height 
of 0, followed by Add. Select Close. 

 
The antennas are added to the current relief. 
 

• From the top menu select Reset All Links. 
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• Double left mouse click on the area labelled 4 in the 2D View. 
• In the Shape Editor, select a Dome shape with an Angle of 45 

degrees, Start Height of 0, followed by Add. Select Close. 
• Repeat the process for areas labelled 5, 6, 7 and the pink area 

(webbing). 
 
 
 
 
 
 
The coin is now complete. 
 
 
 
 
 
 
 
 
 
 
 
 

• Select File > Save As Coin in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 

Bitmap to Vector - Toucan Link Exercise 
 
Colour linking can be used to highlight areas to obtain vectors, using the Bitmap To 

Vector  feature. This allows you to calculate the vector boundary of the selected 
primary colour in the bitmap image.  
 
The following exercise will show the application of this feature. 
 

• Select Open Model.  
• Select the folder: D:\users\training\ArtCAM Data, and change Files of 

type: to Bitmap Files. 
• Select the file toucan.gif, followed by Open. 
• Leave the Set Model Size dimensions as default, and select OK. 
• Left mouse click on the first green colour in the colour palette (make 

primary) 
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• Double right mouse click on the next 5 green colours (to link to 
primary) 

• Double right mouse click on the red and yellow colours. 
 

 
 
The toucan is now surrounded by a single green 
colour. 
 
For the body part of the toucan, the feet and the red 
beak are not required, so they were also linked to the 
green.  
 
A single vector from the boundary of the Primary 
colour will now be created. 
 
 

 
• From the Vector creation toolbar at the top of the screen (or assistant 

tab) select Bitmap to Vector.  
 
 
• Enter a Pixel Tolerance of 1, select the option 

Keep Lines and enter a Min Pixel Length of 5 
and select Create Boundary.  

• Select Create Vectors and close the form. 
• Toggle Bitmap visibility  in the Bitmap 

Layers Tab to hide the Toucan image.  
 
 
 

 
 
A single closed vector has been generated on the primary 
colour(s) boundary. Adjusting the pixel tolerance will 
define how close the vector will follow the primary colour 
boundary.   
 
 
 
 

 
• Delete the square outside vector. Double left mouse click on the bird 

vector to open the Shape Editor. 
• Select a Dome shape with an Angle of 45 degrees, followed by Add. 

Select Close. 
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• Select Reset All Links. 
• Select the Yellow colour using the left mouse button (make Primary) 

• Select Bitmap to Vector,  followed by Create Vectors (to create the 
feet). 

 
• Select the Red colour using the left mouse button. 

• Select Bitmap to Vector,  followed by Create Vectors (to create the 
beak) 

 

• Toggle Bitmap visibility  in the Bitmap Layers Tab to show the 
Toucan image.  

• Shift Select the new toes and beak vectors. 
• Select a Dome shape with an Angle of 45 degrees, followed by Add. 

Select Close. 
• View the results in the 3D view. 

• Select Colour shade  to apply the bitmap. 
 
 
 
 
 

The example will be completed by subtracting 
the white coloured area to generate the eye. 
The wing will also be added.  

 
 
 
 
 
 

• Double left mouse click the white colour directly from the relief. 
• Select a Flat shape with a Start Height of 0.5mm and select Subtract. 

 
• Single mouse select the blue colour defined at the bottom of the main 

wing (to make primary). 
• Double right mouse click the dark blue colour (in palette) defined as the 

top part of the wing. 
 
The two blue colours are linked to create a single colour for 

the wing. 
 
• Double left mouse click the blue wing colour and set a Dome shape with 

an Angle of 25 degrees.  
• Select Add, followed by Close. 
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• Toggle Colour shade  to confirm the 
results. 

 
 
 
 
 

Create Relief Layer from Bitmap Layer 
 
ArtCAM can create a Relief layer from an Imported Image.  
 

• Select.  
• Select the folder: D:\users\training\ArtCAM Data.  
• Select Files of type to be Bitmap Files (*.gif). 
• Select the file Knockout.jpg, followed by Open. 
• Change the origin to the centre and leave the dimensions as default. 
• Select OK. 
 

The option Scanned d.p.i. (dots per inch) allows the model size to be changed by defining the 
required resolution. 
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• From the Bitmaps layers tab, select Create Relief Layer.  
 
 
• In the Scale Relief Height form, enter a 

New Height of 3mm. 
 
• Select OK. 
 
 
• View the new Relief in the 3D View window. 

 

 
 
 
A new Relief layer has been created from this Bitmap 
named Bitmap Layer. 
 
 
 
This Scale Relief Height has limited the height of the Relief to 3mm. The Relief generated 
varies in height according to the bitmap pixel colour below it. The relief height will be at the 
highest level in the lighter coloured areas and lowest in the dark areas. 
 
The relief therefore varies in height between Z 0 and Z 3mm. Areas of no relief are evident as 

the bitmap in these areas are black in colour. Note: Draw Zero Plane is off.  
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• Create a rectangle of size of Width 1024mm and Height 768mm with 
Centre Point at X0 Y0. 

 
This rectangle vector defines the border edge of the image. 
 

• In the Shape Editor, select a Flat shape with a Height of 1mm, 
followed by Add. Select Close. 

 
A 1mm base has been added to the Relief eliminating the zero relief areas. To complete the 
Relief a smoothing pass will be applied to reduce the surface irregularities. 
 

 
 

• From the Relief Editing Toolbar, Select Smooth Relief.  
 

 
 

• With the Whole Layer option ticked and 
Smoothing Passes as 2, select Apply. 

 
 
 
 
The Model is complete. 
 
 
 

• Save the Model and close. 
 
 
 
 

                                                                                  
                                                               Issue ArtCAM Pro 2010                                                                  5.11 



5. Pictures                                                                                 ArtCAM  

 

5.12            Issue ArtCAM Pro 2010 



ArtCAM                               6. 3D Blend and Fade Relief 

6. 3D Blend and Fade Relief 

Overview 
 
The 3D Blend creates the Relief form either inside a closed vector or between two closed 
vectors. The height and shape across the void is controlled by a series of standard, cross 
sectional forms or a user defined Z modulation curve. 

Star Exercise 
 
• Open the model star-blend.art from: D:\users\training\ArtCam Data. 
 

 
 
 
This model contains various vectors to demonstrate the 3D 
Blend Relief options. 
 
 
 
 
 

• In the Relief Tools area, select Create 3D Blend.   
 
 
 
The 3D Blend assistant page appears providing a 
comprehensive range of the options. The 3D blend Relief is 
either generated from a single vector to a central or user 
defined point, or across to an inner vector using one of the 
Profile types, displayed in the page. 
 
 
The final shape of the Relief is controlled by a combination of 
the type of Profile and Height definitions selected. 
 
 
 
 
 
The above options combined with Add, Subtract, Highest and 
Lowest, provides you very powerful commands. 
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• Select the Star vector and shift and select the Circle as well. 
• Select the Linear Profile option. 
• Enter a Border Height of 0 and an Inner Height of 5mm. 
• Select Inner Vector Edge and select the option Fill Inner Vector.  
• Select Add, followed by Create Blend. 
• Press F3 to view in 3D. 
 

 
 
The Relief has a Linear blend from the 
outer to the inner vector. It then continues 
at constant height (5mm) across the area 
inside the inner vector. 
If Fill Inner Vector was unchecked, the 
circle would be open (no relief). 
 
 
 
 

 
• Select Undo (Ctrl + Z). 
• Select the outer star vector only with the Smooth Profile option selected. 
• Select the option Select Point With Cursor and enter X0 and Y10.  
• Select Add, followed by Create Blend. 

 
 
 
 
A smooth blend Relief is produced with an 
offset vector blend producing an offset 
centred star shape. 
 
 
 
 
 
 

 
 
The next part of the chapter will compare the 
addition of different cross sectional, Selected 
Vectors numbered 1 to 3 as shown. 
 

 
 

 
Each vector will produce a different shape when scaled across the relief to the defined 
heights. The Selected Vector is always picked last. 
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• Select Undo (Ctrl + Z). 
• Select the outer followed by the inner vector and with the 3D Blend page 

open, select the Profile option Selected Vector. 
• Hold shift and select the cross section vector 1 from the 2D View window. 
• In Blend from Border to: set Inner Vector Edge and tick the box Fill 

Inner Vector.  
• Select Add, followed by Create Blend. 

 
 
 
A new Relief is created from cross section, 
vector 1 scaled between the inner and outer 
vectors. It then continues at constant height 
(5mm) across the area inside the inner vector.  
 
 
 

• Select Undo (Ctrl + Z). 
• Select the star vector, shift select the circle vector and then the cross 

section, vector 2.  
• Select Highest, followed by Create Blend. 

 
 
 
The new Relief has been produced as the 
scaled vector 2 between the inner and outer 
vectors. It then continues at constant height 
(5mm) across the area inside the inner 
vector. 
 
 
 

• Select Undo (Ctrl + Z). 
• Select the star vector and shift select the cross section, vector 3.  
• Select Middle of Border Vector. 
• Select Highest, followed by Create Blend. 

 
 
The shape of the Relief is controlled by cross 
sectional, vector 3 running from the outer 
star vector inwards as well as from the 
centre outwards. The maximum height 
(5mm) occurs exactly half way between the 
outer star vector and the centre. 
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Fade Relief 
 
This command will reduce a relief down by a percentage (100% is down to zero) within a 
specified area. 

Shoe Sole Exercise 
 
• Open the model shoe-tread.art from: D:\users\trainingArtCam Data. 
 

 
 
 
 
This shoe sole Relief was generated 
from vectors, created by opening a 
picture file. The sole needs to be faded 
to generate a better design. 
 
 

 
• Select the 2D View. 

• From the Assistant’s page, select Fade Relief.  
 
 

 
 
Fade Strength can be set anywhere from 1 to 100%, 
with 100% being faded down to 0 and 50 % down to 
half the current height in Z. 
 
The reverse option allows you to fade upwards 
instead of downwards. 
 
Linear Fade, with fade the whole relief between the 
start and end of a line. 
 
Radial Fade will produce a radial fade from a central 
position. 
 
Between Boundaries will limit the fade area between 
two selected vectors. 
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• Ensure Fade Strength is set at 100% and Fade Type Linear is selected. 
 

• Using the left mouse button, Drag and drop the cross hair  below 
Fade from: into the location as shown below as number 1. 

 
The X and Y coordinates are updated to reflect the position, 
 

• Repeat the above and drag the cross hair  below Fade to: to the 
number 2 position shown below. 

 
 
 
 
 
 
Position 1 shows where the Fade is going to start and the 
Position 2 where it will end (to Z=0)  
 
 
 
 
 
 
 
 
• Select Create. 
• Select F3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The toe region has faded. The X and Y values are kept even after undo,  to allow 
different options.  
The Fade is parallel to the line, so if angled points were selected, the fade would also be 
angled. 
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7. Extrude, Spin, Turn and Two 
Rail Sweep 

Overview 
 
Extrude, Spin, Turn and Two Rail Sweep are commands that create Reliefs from cross 
sections along Vectors. These functions can allow the creation of complex and free form 
shapes quickly. A Relevant example will be used to demonstrate each of these functions. 
 

 

Extrude Relief 
 
An Extruded Relief is produced using two or more vectors. The Relief is produced as a 
swept form of the Start Profile vector along the Drive Curve vector. If you use a different 
End Profile vector, the Relief will change shape from one end of the drive curve to the other. 
A fourth curve known as a Z modulation curve determines the shape of the swept relief in the 
Z direction. 

Extrude Relief Exercise – Picture Frame 
 

• Select File > Open or  
• Load in the model Picture frame.art from: D:\users\trainingArtCAM 

Data. 
 

 
 
The model contains two vectors.  
 
The rectangle represents a drive 
curve. This curve can be open or 
closed (as in this case). 
 
The small vector shape is the Start 
Profile (section). 
 
 
 
Note: The profile vector is the exact size that is required and can be located anywhere in the 
2D View. Also it must be a single open vector (not Grouped). 
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• Select Extrude  from the Relief Tools tab.  
 

 
 
 
 
The Extrude page provides the options for the user to 
create the required Extruded Relief shape.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Select the Rectangle vector with the left mouse button, followed by Select 

in the Drive Curve section of the form. 
 
 
The Drive Curve vector is highlighted.  
 
The small green square indicates the Start of 
the Curve, where the Start Profile will be 
located. 
The small lines running off the sides indicate 
which side of the vector the sectional profiles 
will be extruded along. These options can be 
changed by ticking the relevant boxes as 
shown below. 
 

 
 
• Select only the option to Create square corners. 
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• Select the small open vector with the left mouse button, followed by 
Select in the Start profile section of the form. 

 
 

The Start Profile vector is highlighted.  
As before, the Green square indicates 
the Start of the section. 
The small lines running off the curve 
indicate whether the Relief would be 
positive (ticks inside) or negative (ticks 
outside). For this exercise, a positive 
Relief is required. 

 
The anchor point is critical in this case as it will dictate which part of the profile is on the 
outside of the picture frame. A comparison is shown below. 
 
• Leave the anchor point in its current position, but select Invert Curve in Z 

to create a positive relief. 
 

 
 
 
 
This option can be selecting if an End Profile of a 
different shape to the Start Profile is required.  
By default the End Profile is the same as the Start 
Profile.  If an End Profile is required, the Use 
separate end profile field must be selected to provide 
access to the required selection options. 
 
 
 
 
 
 
This area of the page enables you to include a Z 
modulation Vector. This controls the Relief Height 
along the Drive Curve. As above, this must be 
selected to reveal the selection options. 
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Similar to Shape Editor, this page controls the method 
to combine the shape with the existing Relief. 
 
• Ensure Add is selected. 
 
• Select Calculate to create the relief. 
• Close the form and view the results in 3D. 
 

 
 

 
 
 
 
Square corners have been created because the option was 
selected in the Extrude form. 
 
 
 
 
 
 
If the option Move anchor point to other end was 
selected, then the profile vector would be reversed 
during the extrusion. The result would then be as shown 
to the right.  

 
 
 
 

 
• Select File - Save As, enter the File name as training-PictureFrame and 

save it in: D:\users\training\COURSEWORK\ArtCAM Pro-Jobs. 
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Spin Relief 
 
A Spin Relief is produced, by spinning a single Cross Sectional vector around its own start 
point (green square). Spin Relief also allows the inclusion of a separate end profile and Z 
modulation vector. 

Spin Exercise – Leaf shape 
 

• Select File > Open or  
• Load in the model Spinleaf.art from: D:\users\trainingArtCAM Data. 

 
 
 
The model includes two vectors and a 
bitmap of a leaf shape. 
 
 
 
 
This Polyline will be spun around its own 
start point (shown as a green square) to 
generate a Relief. The Polyline or Start 
Profile determines the actual size of the 
model and has to be a single joined vector. 
 
 
 
 

• Select Spin  from the Relief Tools area. 
 
 
 
 
 
 
 
 
 
The profile by default will be swept a full circle (360 
degrees). Unticking this option will allow the start and end 
angles to be specified. 
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• Select the profile vector with the left mouse button. 
• On the Spin page, click Select. 
 
 

 
 
A positive Relief is required therefore the 
indicator marks should point inwards as 
shown. 
 
The start point green square is on the left hand side indicating the anchor point at which this 
profile will spin around. 
 
 
If necessary, both options can be changed by selecting 
the relevant box. 
 
 
• Ensure Add is selected. 
 
• Select Calculate to create the relief. Close the form. 

• From the 2D view tab, select Preview Relief Layer.   
 
 

 
 
The Relief Layer is displayed in the 2D view. 
 
The result shows how the profile was swept full circle 
around the anchor (start) point. 
 
 
 
 
 
 
 
 
Switch to the 3D view to see the results. 
 
This process will be repeated to include the Z 
modulation vector. 
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• From the Relief Editing Toolbar, select Reset Relief.  

• Return to the 2D view and Switch off Preview Relief layer.  
 

• Select Spin  from the Relief Tools area. 
 
• Reselect the profile vector as the Start profile 
 
• Tick the option Use Z modulation profile, to reveal the further options. 
 
• Select the curved vector, followed by Select in the Z modulation section of 

the form. 
 

 
 
• Select Calculate to create the relief. Close the form. 
 
 
 
 
Switch to the 3D view to see the results. 
 
 
The six curve profile has scaled the Relief in the Z-axis 
(along its length). 
 
The final leaf shape will now be completed. 
 
 
 
 
 
• From the colour palette, ensure Red is selected as the 

Primary colour.  
 
• From the top menu. Select Reliefs > Keep under colour.  
 
 
This will reset all areas of the Relief NOT under the primary colour (red).  
 
 
Note: Selecting ZERO REST in Shape Editor would give the same result. 
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• View the result in 3D. 
 
The leaf pattern has been created 
from the original swept relief. 
 
 

 
 
 
 
 
• From the top menu, select Bitmap>Colour>Reset All Links. 
 
 
The previously linked green colour has been reset. This has 
exposed the leaf ‘veins’. 
 
 
• Enter Shape editor using the green 

colour (double left mouse click directly in 
the view or palette) 

 
 
• Subtract a triangular feature using a 45 

degrees angle. 
 
Note: subtracting a 45 degree angle is equivalent to 
adding -45 degrees. 
 
 
 
 
 
 
 
The ‘veins’ have been added to the final relief. 
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• From the 3D view tab, select Colour Shade.  
 
 
 
 
The original bitmap has been applied to the 
underlying relief. 
 
 
 
 
 
 
 
 
 
• Select File - Save As, enter the File name as training-SpinRelief and 

save it in: D:\users\training\COURSEWORK\ArtCAM Pro-Jobs.  
 
 

Turn Relief 
 
The Turn command takes a vector (cross section) and rotates it over itself to generate a 
Relief.  
The axis of rotation is defined along the line between the start and end points of the vector. 

 

Turn Exercise - Castle 
 
 

• Select File > Open or  
 
 
• Load in the model Castle turn.art from: 

D:\users\trainingArtCAM Data. 
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• Select Turn,  from the Relief Tools area. 
 

 
 
 
The Turn page provides an option for vector selection 
(Profile), Z Scale Factor for the Z Height and Combine 
Relief creation method. 
 
 
 
 
 
 
 
 
 

 
 
 
• Select the ‘left tower’ vector as shown with the 

left mouse button. 
• On the Turn page, click Select. 
 
 
 
 
 
 
• Select Add, followed by Calculate. Select Close. 
• View the results in 3D. 
 
 
 
 

 
 
The Relief is turned out (180 degrees) on the 
page. The Z height of the Relief was dictated by 
the size of the vector profile itself.  
 
This will be repeated but a scale factor will be 
applied.  
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• From the Relief Editing Toolbar, select Reset Relief.  
 

• Select Toggle Vector Visibility,  from the 3D view Toolbar. 
 
 
The 2D vectors are displayed in the 3D view. The 
remainder of the castle will be created within the 
3D view. 
 
• Reselect the same ‘left tower’ vector 

and then Spin  from the Relief 
Tools area. 

 
 
 
• Change the Z Scale factor to 0.5.  
 
• Select Add, followed by Calculate. Select Close. 
 
 
 
 
 
Without changing the X and Y parameters, the 
Relief height (Z) is now reduced by 50%. 
 
This can be repeated to create the second identical 
tower. However for this example, the Mirror 

Merge Relief  function will be shown. 
 
 

• From the Relief Tools area, select Mirror Merge Relief.  
 
 
 
 
The Relief will be mirrored across the origin based on the 
option selected. 
 
 
• Select the option Left over right and then 

Apply. 
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The remainder of the castle will be merged. 
 
• Select only the outer rectangular vector. 
• Within Shape Editor, Merge High a flat plane of height 0.8mm.    
 
• Shift Select the four ‘cross’ shapes and the entrance (door) 
 
• Within Shape Editor, Select Zero.   
 

• Select Toggle Vector Visibility,  from the 3D view Toolbar to hide 
the vectors. 

 

 
 
 
• Select File - Save As, enter the File name as training-castleturn and 

save it D:\users\training\COURSEWORK\ArtCAMPro-Jobs 
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Two Rail Sweep 
 
The Two Rail Sweep provides a powerful Relief creation tool with a variety of controlling 
options. The basic principle is that one or more scale sectional vector forms (profiles)  are 
extruded between two Drive Curve vectors (rails). 
 

• Select File > Open or  
• Load in the model two rail sweep.art from: D:\users\trainingArtCAM 

Data. 

 
 
These three examples will introduce the two rail sweep function capability.  
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Leaf shape 
 
 

• Select Two Rail Sweep,  from the Relief Tools area. 
 
 

 
The form enables the required vectors to be selected. 
 
The two drive rails must have the same direction (as 
indicated by the arrows once selected) 
 
The Z modulation vector (as with extrude and spin) is 
selected here. 
 
 
This section allows multiple cross sections to added and 
individual positions specified. (Note: Cross sections 
must be open, ungrouped vectors) 
 
 
 
 
 
 
 
The final scaling of the relief can be managed in this 
section of the form. 
 
 
 
 
The usual Combine options are selected here before 
selecting Calculate. 
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• Select the left hand leaf vector identified as the First drive rail. 
 
 
• Click select in the form next to Top Drive Rail.  
 
Arrows have appeared on the vector indicating its direction. The 
Green Square and red letter A also signify the start point. 
In the status area, the First Drive Rail status changes from Not 
selected to valid. 
 
 
 
• Select the right hand leaf vector identified as the Second drive rail. 
 
 
• Click select in the form next to Bottom Drive Rail.  
 
 
As before, arrows indicate its direction. The Green Square and red 
letter B signify the start point. 
In the status area, the Second Drive Rail status changes from Not 
selected to valid 
 
 
 
 
If required, the arrow/vector direction can be changed by 
selecting the relevant check box. 
 
 
• Select the profile vector identified as Cross section. 
 
 
• Click the Add Cross Section button in the form.  
 
In the status area, Cross section 1 is now listed with its status as valid. The number 1 
indicates its start point.  
 
• Ensure Scale Height and Width and the combine option Add are both 

selected. 
 
• Select Calculate and view the resulting relief. 
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The cross section has swept between the two rails 
to create the leaf shaped relief.  
  
 
 
 
 
 
 
 
 
 

• From the 3D view toolbar, view the relief along the Y axis.  
  
 
 
Selecting the option Scale Height and 
Width meant that the Z height of the cross 
section is scaled relative to the width 
(across drive rails). 
 
 
Not selecting the Scale Height and 
Width option would have given a 
constant height. 
 

Star shape 
 
Drive curves/rails can also be closed vectors. 
 
• Repeat the above procedure to create the star shaped relief. Use the 

vectors as labelled.  
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Multiple sections 
 
Any number of sections can be added and used in the calculation of the relief. The position of 
the cross sections can also be specified. 
 
Vectors can also be selected prior to opening the two rail sweep form.   
 
• Shift-select the two curves and sections in the order shown. 
 
 
 

 
 
 
 

• Select Two Rail Sweep,  from the Relief Tools area. 
 
 

 
 
 
The vectors are identified with arrows and numbers to specify their start and end positions.  
 

• Re-select and ensure only the Section 1 vector   is selected. 
• Select   
 

 
 

This additional section has been inserted midpoint between the previous two. 
 

1 

2 

4 3 
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• In the Cross Section status area, select the 

word Position adjacent to Cross section 2. 
 

 
 The word Position changes to 1st Rail. 
 
 
• Select the drive curve vector in the area shown to 

define the first point. 
 
 
The word Position changes to 2nd Rail. 
 
 
 
• Select the second point as shown below to define the new position. 
 

   
 
 
• Untick the option Scale Height and Width. 
• Select Calculate and view the results. 
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8. Weaves 

Weave Relief 
 
A Weave Relief is generated from a series of overlapping vectors and a Section vector, 
using the Weave Wizard.  
 
 
 
 
 
 
 
 
 
 
 

Weave Exercise 1 
 
• Create a New Model with Width and Height of 25mm and origin in the 

centre. 
• Create three vectors for the Drive Curves and a small open square 

vector for the Cross Section, as shown in the image below. 
 

 
 
The overlapping vectors will be used as the centrelines for the Drive Curve.  
The smaller vector will be the Cross Section of the Weave pattern and must be an Open 
vector. The small vector section is actual size of the desired relief. 
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• Shift select the Drive Curve vectors 

and the Cross Section vector last. 
 

 
 

The vectors turn pink as they are selected and a 
box appears around the extents of the vectors to 
show that they are selected. 
 
 
 
 
 

• Select Weave Wizard.  
 

 
ArtCAM creates the weave pattern at the intersecting 
regions of the vectors. 
 
The direction of the vectors determines underpass and 
overpass which vector goes under or over the others. 
 
Length of Crossover determines the length of the 
weave that will be lowered or raised at the crossover 
point. This is usually Relative to Cross Section. 
 
% Depth of underpass and % Height of overpass 
allow you to determine the percentage that the height 
of the weave Cross Section is lowered or raised at the 
crossovers. 
The Corner Shape can be Round or Square, and the 
relief is combined in the same manner. 

 
 
 
• Leave the defaults options and select OK to calculate the relief. 
 
• Select the 3D View tab (or F3) to view the result. 
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Weave Exercise 2 
 
• Create the following vectors, including the small half Ellipse cross 

section vector. 
 

 
 
 
If the cross section is to big the weave will cross 
over itself. 
 
 
 
 
 
 
 
 

• Shift select the Drive Curve vectors 
and the Cross Section vector last. 

 

• Select Weave Wizard . 
• Select Relative to cross section 

and enter a value of 1.5mm, select 
Square, followed by OK. 

 
 
With Square corners selected, the Weave has 
sharp edges, rather than rounded.  
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Fruit Plate Exercise 
 
• Open the model fruits-on-plate.art, from the ArtCAM Data folder. 

 
 
 
These vectors will be turned into a plate relief, using swept 
profiles. 
 
 
 
 
 
 

 
• Select just the pineapple Dome vector and generate an Added Dome 

Relief with an Angle of 45 degrees, Start Height of 0.4mm and with No 
Limit selected. Select Close. 

 
    
 
 
 
 
 
 
 
 
 
 
• Use the overlapping diamond vector group and generate an Added 

Pyramid Relief with an Angle of 25 degrees, Start Height of 0 and with 
No Limit selected. Select Close. 

 
 
 
 
 
 
 
 
 
 
 
 
 
The generated Relief goes over the edge of the pineapple. This ‘excess’ relief can be removed 
by applying Zero Rest in the Shape Editor. 
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• Double click the round pineapple vector. In 

Shape Editor, select Zero Rest. Close the form. 
 
 
 
 
 
 
 
 
 
• Use the left middle leaf vector and generate an Added Dome Relief with 

an Angle of 45 degrees, Start Height of 0.1mm with No Limit selected. 
Select Close. 

 
    
 
 
 
 
 
 
 
 
 
 
• Use the right middle leaf vector and generate a Merge High Dome 

Relief with an Angle of 45 degrees, Start Height of 0.2mm with No Limit 
selected. Select Close. 

 
 
 
 
 
 
 
 
 
 
 
 
• Use the outer leaf vectors and generate a Merge High Dome Relief with 

an Angle of 45 degrees, Start Height of 0.4mm with Limit to Height at 
1mm. Select Close. 
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• Select the three vectors for the banana and generate an Added Two Rail 

Sweep Relief.  
 
 

 
 
 
 
 
 
 
 

 
 
 

• Generate an Extruded Relief  using the line as a Drive Curve, the 
arch as the first section and the angle as the end section. Select Merge 
Highest. 
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• Select the pear shape vector and generate an Added Turn Relief.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the stalk vector of the pear, and generate a Merge Highest Turn 

Relief. 
 
 
 
 
 
 
 
 
 
 
 
 
• Use the leaf vectors and section to generate a Merge Highest Two Rail 

Sweep Relief.  
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• From the main Polyline vector, Add a Spin Relief,  with the option 
Invert curve in Z selected. 

 
 
 

 
 
 
• Select the grouped chain design of vectors 

and then the nearby small vector, as shown 
below. 

 
 
 
• Add a Weave Relief with the following values and select OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the Text fruit and generate an Added Pyramid Relief with No limit 

and a Start Height of 0 and an Angle of 60 degrees. 
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• View the final Relief. 
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9. 3D Clipart and Texturing 

3D Clipart 
 
The 3D Clipart dialog box opens when the user imports an existing externally stored Relief 
using the Paste Relief from A File option. The 3D Clipart form enables the Relief to be 
scaled, re-positioned, re-orientated, copied, etc. Before being combined into the current 
model. 

Lady Exercise 
 
• Select Open Model.   
• Open Pend_frm.rlf from: D:\users\trainingArtCAM Data. 
  

 
 
On opening the Relief, ArtCAM automatically 
generates both a Bitmap (colour) and Greyscale 
representation in the 2D view.  
 
The model size and resolution is the same as the 
imported Relief before it was originally exported from 
ArtCAM as a .rlf file. 
 
This summary can be seen at the top of the Assistant 
tab. 

 
 

 
 

• Select Paste Relief from a File,  from the Relief Tools area. 
 
• Browse and select the file Lady.rlf from the D:\users\trainingArtCAM 

Data directory and select Open. 
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The 3D Clipart form and a vector outline of 
the imported relief appear in the 2D View. 
 
 
 
A Preview of the Relief is displayed as a 
vector outline, and is currently too large. It 
will be transformed, sized and positioned, 
using the 3D clipart form before being 
Pasted onto the existing model.  
 
 
 

 
• Select the Scale tab.  
• Enter the New Scale as 30%. 
• Select Apply. 
 

 
The Relief could also be scaled manually by 
dragging the corner handles of the relief vector, 
with shift held down to maintain the proportion. 
 
Now the vector (and associated relief) can be 
moved to the centre of the pendant. 
 

 
• Move the cursor on the vector outline so that Move Cursor appears. 
• Select the Left mouse button and move the mouse to ‘drag’ the Relief.  
• Release the button when the vector is suitably positioned.  
(Note: Keyboard shortcut to centre in page is F9) 

 
 
 
Now that the Clipart is suitably positioned, the inherent Z 
Range value can be altered to provide independent control to the 
final Z height of the new Relief. 
 
 
The Clipart summary shows the vector Relief 
height as nearly 2.6mm with the current Relief 
at nearly 0.7mm.   
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• Click the Size page on the 3D Clipart dialog box.  
• Input a value of 0.5 in the Z Range box to control the new Relief height 

and select Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click the Mode tab on the 3D Clipart dialog box.  
• Ensure that the Add mode is selected, click the Paste button, and then 

close the 3D Clipart form. 
 
 
 

 
 
 
 
The new Relief has been added to the original pendant adding an additional height value of 
0.5mm to the model. 
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Texture Relief 
 
A Texture will be applied between the head and the outer frame. To define this area, a 
vector can be created around the central mid-grey coloured area. A vector around the profile 
of the head was created during the last clipart operation. The Texturing will be created 
between the two vectors. 
 
• In the Bitmap view, double click within the grey colour shown.  
• Close the Shape Editor form. The selected grey colour is now assigned as 

the Primary colour. 
 
 
 
 
 
 
The grey colour also applies to other tiny areas and as a 
result several additional vectors are created, but these can 
be ignored. 
 
 
 
 

• Select Bitmap To Vector.    
• Select Create Vectors. 
• Shift Select the new oval outer vector and the inner head vector. 

• Select the Texture Relief.  
 

 
The Texture Relief dialog appears: 
 
This dialog box allows the selection of several pre-
defined textures including Sphere, Ellipse, Cone, 
Pyramid and Weave.  
 
Other options provide the user with Sizing and Scaling 
capabilities to adjust the Texture exactly to the desired 
form. 
 
The From File option enables a user defined Relief or 
even Bitmap to be imported for use as a Texture. 
 
If selected, Blend Edges allows the input of a fading 
distance from the vector into the Relief area from zero to 
the full Texture - Z Height. 
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• Enter the details into the form as shown above. Select the Pyramid shape, 
enter the Size as 0.5mm, the Truncation as 50% the Z Height as 0.1mm 
and select the option Blend Edges, entering a value of 5mm and select 
Add. 

 

 
 
• Select File - Save As, enter the File name as lady head pendant and 

save it in: D:\users\training\COURSEWORK\ArtCAM Pro-Jobs. 
 

Paste Relief Along Vector  
 
Paste Relief Along Vector on the Relief Tools allows several copies of the 3D Clipart to be 
pasted along a selected vector. 

Fork Exercise 
 
• Open the model fork.art from: D:\users\training\ArtCAM Data.  

 
 
 
 
 
This model contains the vectors to generate a fork shape. It also 
contains some additional vectors along which a Jewel Relief will 
be pasted. 
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• Select the main fork vector and generate an 

Added Dome relief with an Angle of 90 
degrees and with a Limit to Height of 
1.5mm. 

 
 
 
 
 
 
• Select the bottom curved vector of the decal. 
 
This decal will be added onto the main flat fork relief. 
 
• Generate an Added Dome profile with an Angle 

of 30 degrees. 
 
 
• Select the two side curled vectors. 
• Define a Dome profile with a Start Height of 

1.5mm, an Angle of 30 degrees and select 
Merge High. 

• Select the oval vector and define a Dome profile 
with a Start Height of 1.5mm, Angle of 30 
degrees and Merge High. 

 
 
 
• View the Relief. 
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• Select the inner closed vector around the decal as 

shown. 
 
An imported Relief will be pasted along the centre of this selected 
vector. As with Paste Relief from a File, This relief can also be 
modified prior to pasting. 
 
• From the Relief tools area, select Paste Relief along 

Vector.  
• Select the Relief Jewel.rlf from the ArtCAM Data folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The vector outline appears in the 2D View and the Paste along a curve page appears in the 
Tool Settings Tab along with the 3D Clipart dialog box in the graphics area. The 3D Clipart 
box is not used in this case as the Mode is already set to Add. It must remain open until the 
Paste along a curve process is completed. 
 
 
 
The Spacing setting in the Assistant page allows you to 
define the space between adjacent copies of the clipart. 
100% means they will be next to each other, less than 100 
means they will overlap, and greater than 100 means there 
will be a gap. 
 
The Start size and Finish size define the sizes of the Relief 
at the start and end of the curve.  By making the sizes 
different, ArtCAM will scale the clipart automatically from 
one size to the other.  
 
• In the Paste along a curve page, set Spacing 

as 300%, Start and End size as 10% and select 
Adjust to fit exactly.  
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• Select Paste.  
• Do not close either the Paste along a curve or the 3D Clipart dialog 

boxes. 
 
 
 
 
The vectors indicate where the new Reliefs have been added to the 
original Relief. 
 
 
 
 
 
 

 
• Select the vertical vector in the middle of the fork. 
• In the Paste along a curve form, change the Spacing to 200%, a Start size 

of 10 % and an End size of 20%. 
• Select Paste.  
 
 

 
 
The gem details have all been added.  
 
 
 
 
 

 
• Close the Paste along a curve and 3D Clipart dialog boxes. 
• View the results. 
 

 

9.8     Issue ArtCAM Pro 2010 



ArtCAM                                    9. 3D Clipart and Texturing 

Motif Exercise 
 
 
• Create a New Model with a Height of 25mm, Width of 50mm and origin 

in the centre. 

• Select Paste Relief from a File  and open the Relief Leaves.rlf from 
D:\users\training\ArtCAM Data. 

 

 
 
 
• Select the Rotate tab on the 3D Clipart dialog. 
• Enter in the Rotate by angle field an Angle of -40 degrees and select 

Apply. 
• Select the Mode tab, followed by Add and then Paste. 
 

 
 
 
The vector rotates to reflect the change in Angle.  
 
When the Paste box is selected, the new Relief is 
Added to the model page. The 3D clipart form 
remains open by default in anticipation of further 
pasting operations. 
 
 
 

 

• In the Rotate tab, select the Horizontal button.  
• Switch to the Move tab and set the Move X origin by field to 25. Select 

Apply followed by Paste.  
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• Close the form and view the results. 
 

 
 
 
Pasting a relief can also be accessed from the main drop down. The Motif will now be 
completed by adding a central flower relief. 
 
 
• Select Reliefs > Import from the top menu bar and import Flower.rlf from 

the ArtCAM Data folder 
 

 
 
• Select the Scale tab on the 3D Clipart dialog and set the new scale % 

field to 60%. Select Apply. 
• In the 2D View, select and drag the vector outline of the flower between 

the leaves, as shown in the image below. (or press F9 to centre in page) 
 
• On the Mode tab, select a Start Height of 0.5mm and the Mode as Merge 

Highest. 
 
 
• Click Paste and then Close. 
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• Select File - Close Model. (save if desired) 
 

Relief Wrapping 
 
When a Relief is added onto a surface it is normally projected down the Z-axis. A Relief can 
also be wrapped onto a surface within the 3D Clipart or Vectors can be wrapped onto the 
surface. The process of Wrapping will ‘bend’ the Relief to wrap around the model without 
changing its overall size. (Minimise distortion) 

 
 

In the above diagram the vector A is wrapped onto the relief B.  
 
On the left hand side, the vector is not wrapped but is simply projected down Z and 
therefore the finished vector C is distorted as it goes over the curve.  
 
On the Right hand side the vector is wrapped to produce vector D, which retains the same 
dimensions along the 3D surface as the original 2D vector. 
 
In ArtCAM in addition to projecting down Z it is possible to wrap radially, such as around a 
sphere, or cylindrically, like a tube in the X or Y direction. 
 
This will be demonstrated with a simple example. 
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Wrapping Exercise 
 
• Create a New Model of size X 100 and Y 100 with the origin in the Centre  
• Create a Circle of Diameter 80mm with the Centre at X0 Y0. 
• Remove the left half of the circle using Node Editing. 

• Create a Turn Relief  with a Z Scale Factor of 1. 
 
 
 
 
A second Relief will be pasted onto this 
hemisphere. 
 
 
 
 
 
 
 

• Select Paste Relief from a File  and select the Relief dolphin.rlf from 
D:\users\training\ArtCAM Data.  

• Select the Scale tab on the 3D Clipart dialog and set a New Scale % of 
125%. Select Apply 

• Ensure combine mode is set to add, followed by Paste (do not close the 
3D Clipart form). 

• Select the 3D View to view the Relief. 
 

 
 
The default option, project down Z 
when applied to a very rounded shape, 
such as this Sphere has caused the 
resulting relief to be elongated as it is 
projected onto a steep area. It is 
especially noticeable on the tail area. 
 
 
 

 
 
• Select Undo (Ctrl+Z). 
• On the 3D Clipart dialog, select the Wrap tab. 
 
 
 
 

9.12     Issue ArtCAM Pro 2010 



ArtCAM                                    9. 3D Clipart and Texturing 

 
 
 
 
There are four types of Wrapping - 
Project (default), Radial (for 
Sphere shapes), Wrap X and 
Wrap Y. The Wrap Origin can 
also be set. 
 
 
 

 
 
• Select Radial, followed by Paste and then Close. 
 
 

 
 
 
The dolphin is scaled in such a way as to 
make it look as though it has been 
wrapped around the spherical surface, as 
opposed to simply being projected down 
Z. 
 
 

 
 
• Close the ArtCAM model without saving. 
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10. Relief Layers 

Introduction 
 
An individual Relief operation can be assigned to a Relief Layer. This provides the ability to 
create a model in which the user can switch the Relief components to exhibit different design 
variants. The Relief Layer Toolbar also allows the Shape (combine option) to be changed 
between Layers, and create on the Back Layer. A composite Relief showing both front and 
back layers can be viewed together. 
  

 
Relief layers are controlled by the Relief toolbar. 
This toolbar can be activated by selecting Relief 
Layers from the right hand mouse menu (in grey 

border).    
 

 
 
The following can be managed from the Relief Layers Toolbar. 
 
 
 

 Add a new Relief Layer to the model. 
 

 Import a new Relief Layer from a file. 
 

 Export the selected/highlighted Relief Layer. 
 

 Duplicate the selected Relief Layer. 
 

 Transfer the selected Relief layer to the opposite side (Back Relief Layer). 
 

 Merge (combine) the visible layers to form a new Relief Layer. 
 

 Create a new Bitmap Layer from the selected Relief Layer. 
 

 Delete the selected Relief Layer from the model. 
 

 Toggle the visibility of all the Relief Layers. 
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Lid Exercise 
 
• Create a New Model 100 x 100 with the Origin in the Centre. 

• View the Relief Layers Toolbar.  
• Create a vector Square of Height 65mm at the origin with a Corner 

Radius of 10mm. 
• In Shape Editor, create a Dome shape with an Angle of 90 degrees, 

Start Height of 5mm, Limit to height with a Height of 3mm. Select Add, 
followed by Close. 

 
 
 
The new Relief is automatically assigned to 
the default Relief Layer. A Relief Layer can 
be switched off as required by clicking the 
light bulb icon. Any Relief operations 
assigned to a Relief Layer that is switched off 
will be temporarily hidden from the model. 
 
 
 
 

 

• Create a New Relief Layer by selecting New,  on the Relief Layers 
Toolbar.  

• Make the new Relief Layer 1 active by highlighting the Layer. 
 

 
 
Any further Relief creation will now created on this active (highlighted) Relief Layer 1. 
 
• Switch off the original default Relief Layer by selecting the 

corresponding ‘light bulb’ icon.  
 

 
 
The previously created Relief has now disappeared from the 3D view. Although the Relief is 
hidden, the square vector from which it was calculated is still visible. Vectors are managed 
independently from the Vector layers Toolbar.  
 
 

• Generate a Star vector  with 5 points, at the origin, First Radius of 
20mm and Second Radius of 8mm. 
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• Press F12 and select a Pyramid shape with an Angle of 25 degrees, 
Start Height of 0 with No Limit selected. Select Add and then Close. 

 
 

   
 
 
The Relief Layers Toolbar allows the Combine option (Add, Subtract, Merge High etc) to 
be changed between layers. This can be achieved by selecting the required option in the icon 

adjacent to the Relief Layer name.  
 
Options available (in order) are Add, Subtract, Merge High, Merge Low and Multiply. 
 
 

• Switch on  Relief Layer. 
 
 
The original relief is now visible with the star Relief ‘added’ on top.  
 
 
 
• Double mouse click on the name Relief Layer 1 

and change the name to star. 
 
 
• Change the combine option in the Star Layer from 

Add to Subtract.  
 

 
 
The star relief is now subtracting from the main Relief 
layer below it. 
 
 
Each time the combine icon is selected and changed, 
the composite relief is automatically updated. 
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A Relief on the back will now be generated and combined with the front. 
 

• Switch off  the Star Relief Layer to leave just the default Relief Layer 
visible. 

 

• Activate the Back Relief Tools Toolbar.  
 
 

  
The Back Relief Toolbar provides options to quickly generate a Back 
Relief from the composite Front Relief (visible). 
 

 

 Creates an offset copy (based on value entered) of the composite Relief and places it on 
the Back Layer. 
 

 Creates an inverted copy of the composite Relief and places it on the Back Layer. 
 
 

 Creates a flip copy of the inverted copy on the Back Layer (for machining purposes). 
 
 
 

• Select Invert Composite to Back.  
 

 
 
 
 
 
 
 
 
 
 
 
 

 
An inverted copy of the front composite relief has been created and placed on the Back 
Relief. The Toolbar shows the Back Relief as active, and also creates a new layer called 
Inverted Composite. 
 
• Close or Dock the Back Relief Toolbar. 
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• Ensure the new Inverted Composite Layer is active and switch to the 2D 
view. 

• Select Paste Relief from a File,  from the Relief Creation Toolbar or 
Assistant Tab. 

 
• Browse and select the file Dolphin.rlf from the D:\users\trainingArtCAM 

Data directory and select Open. 

• In the 3D Clipart form, change the Paste mode to Subtract.  
 
• Select Paste, followed by Close. 
 

 
 
The dolphin has subtracted from the inverted 
relief, which once assembled to the front (as 
one half) will result in a positive form.  
 
 
 
 
 

 
 
• Select Front Relief from the drop down 

menu. 
 
 

• Switch on  the Star Layer to show the complete 
Front Relief. 

 
 

• From the 3D view toolbar, select Toggle Back Relief.  
 
 
The Back and Front Reliefs are both shown in combination. 
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The complete model can be exporting for manufacture. ArtCAM can export a complete 
assembly as triangulated mesh data (.stl) to another CAD/CAM system or directly to a 
Rapid Prototyping system.   
 
 

• Select Create Triangle Mesh.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The following options are available: 
 
Open Mesh – No Back face or layer is used so the resulting mesh is left open. 
Close with Back Relief – Combines the back with the front relief to produce a single 
mesh. 
Close with a Flat Plane – Model is closed using a plane at zero Z-height. 
Close with Offset – Use an offset copy of the current model to form the back face. The 
resulting triangulated model will effectively be a hollow shell based on the thickness defined. 
Limit Triangle size – This can be used to define the maximum X and Y length of each 
triangle. Limiting the triangle length will ensure a closer match to curved surfaces of the relief 
when a mesh is generated.  
 
 
• Select the option Close with Back Relief, followed by Create Triangles. 
 

 
 
A single mesh is created from the combination of 
the front and back reliefs. 
 
The volume and weight is also provided in the 
Properties Tab of the form. 
 
This Triangle Mesh can be saved outside of 
ArtCAM using Save Triangles.  
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• If the mesh requires exporting, select.  
 
• Close the form to return to the Relief 
 
 
When the command is closed the Triangle Mesh will disappear. 
 
 
• Select File - Save As, enter the File name as lid-dolphin and save it in: 

D:\users\training\COURSEWORK\ArtCAM-Jobs. 
 
• Select File – Close Model. 
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11. Relief Editing 

Overview 
 
There are several ArtCAM options available to directly edit a Relief model.  

Lizard Relief Exercise 
 
• Open the model Lizard.art from: D:\users\training\ArtCAM Data. 
• Select File - Save As and save the model with the File name  
Training-lizard in: D:\user\training\COURSEWORK\ArtCAMPro-Jobs. 
 
 

 
 
The overall height of this lizard 
can be reduced by using the 
Scale Relief Height function. 
The option, Preserve Detail if 
selected will take longer to 
process but will retain features 
which otherwise may be erased 
with a general scaling. 
 
 
 
 

 
 
At the top of the Assistant Tab, view the Model 
Information. The current Relief.Max. is displayed 
as 38.372mm. 
 

 
 
 
 

 
 

• In the Relief Tools area, select Scale Relief Height.  
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The Scale Relief Height button enables height or 
volume adjustment over the entire Relief. 
Under Mask, the scale height can be under the 
selected Vector, or selected Colour.  
The current height of the model is displayed in New 
Height is then amended to the desired height.  
 
Emboss and Preserve Detail along with suitable 
values will identify small features on the relief and 
scale them locally before merging them with the 
detail on the top. This is necessary to prevent fine 
detail being lost during the overall scaling process. 
 
 
 
 
 
 
 
• Enter a New Height of 35mm, leave the other Parameters as None and 

select Apply. 
 

 
 
 
The lizard Relief now has a Maximum 
Height of 35mm. You can invert it negatively 
for generating a mould as shown below. 
 
 
 
 
 

 

• Select Invert Relief Z Only  in the Relief Tools area. 
 

 
 
 
 
The lizard Relief is inverted, producing a 
negative image. The Relief can be inverted, 
again returning it to its original state. 
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• Select Invert Relief Z Only,  and then select Invert Relief - 

Male/Female.  
 

 
 
 
 
The lizard is inverted and also mirrored. 
It can be inverted, again returning it to its 
original state. 
 
 
 
 

 

• Select Invert Relief - Male/Female  to return to the original state. 

• From Relief Tools, Select Offset Relief.  
 
 

 
 
 
 
 
The Offset Relief button allows you to offset the Relief 
by a certain distance either inwards or outwards. 
 
 
 
 
 
 

 
 
• Select OK on an Offset Distance of 1mm Outwards. 
 
 

The Relief is now 36mm high.  
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A Draft Angle can be added to the Relief. This command is found on the pull down Reliefs 
menu. 
 
• From the Reliefs pull down menu select Add Draft. 
 
 

 
 
The Add Draft Angle dialog box appears and a 
suitable Draft Angle in Degrees value is entered. 
 
 

 
 
• Enter a Draft Angle of 45 degrees followed by Apply. 
 

 
 
 
 
The large Draft Angle exaggerates the effect of 
adding draft onto the Relief. 
 
 
 
 
 

 
 
 
• Select File>Save and then Close the model. 
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Sculpting 
 
Sculpting is used on 3D Reliefs to locally add, remove or smooth the model by dynamically 
using the mouse in the 3D View.  
 
 
The Sculpting Tools can be accessed directly from the Design Tools Toolbar in the left hand 
side. 
 

 
 
..or right-mouse selecting in the 2D/3D view area. 
 

 

Smooth   allows selective smoothing of the Relief as opposed to the generalised effect 
of the Smooth Relief feature on the Relief Tools area. 
 

Smudge  takes a copy of the Relief under the brush and allows it to be dragged to 
another position. 
 

Deposit  adds material to the Relief. 
 

Carve  removes material from the Relief. 
 

Eraser  it’s a selective undo for any part of the Relief during an active session of 
Interactive Sculpting. 
 

Clone  allows cloning certain areas of the composite Relief. 
 
 
Each action has options for Brush Diameter, Strength and Smoothness and different options 
will be available depending on the action chosen. 
 
Additional options within the form also allow the relief to be controlled at a defined height 
and/or linked to the primary colour.    
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Sculpting exercise 
 
This example will show you how to create an entire scene using the Scultping tools 
available in ArtCAM. 
 

• Select Create New Model.  
 
• Enter a Height and Width of 300mm with the origin in the bottom left hand 

corner. 
 
• Open mountains.rlf from: D:\users\training\ArtCAM Data using the 

Relief layers Toolbar.  
 
 
The Relief has been imported on its own new layer. The 
Layer name corresponds to the file name. 
 
 

• As no longer required, Highlight and Delete  the original Relief Layer. 
 

• Select Preview Relief Layer.  

 
 
• Open the bitmap dirt-dry cracked. jpg from the Bitmap layers toolbar.  
 

• Select Create Relief Layer (from Image).  
 
• Enter a New Height of 2.5mm and then OK. 
 
 
 
A new Relief Layer (dirt-dry cracked) has been created from 
the Bitmap (max height of 2.5mm). This has been added to the 
Relief Layers Tab. 
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• Open the bitmap sand. jpg from the Bitmap layers toolbar.  
 

• Select Create Relief Layer (from Image).  
 
• Enter a New Height of 2.5mm and then OK. 
 
 
 
The new Relief layer (sand) has been added.  
 
 
 
• Select (highlight) the mountains relief layer to make it active.  
 
 
• Select Toggle Visibility for the other two relief 

layers to hide them from the 3D View.  
 

• Select Create Bitmap Layer  of the mountains relief layer (to assign it 
colours). 

• Select yellow in the colour palette to assign it as the primary colour.  

• Select Colour Shade  from the 3D view toolbar. 

• Select the sculpting tool Deposit.  
 
• Select sand from the Tool Settings pull down menu. 
 
The sculpting brush takes form of the sand relief texture layer, 
created earlier. Any relief layer created can be selected here.  
 
• Select a Diameter of 100mm, Strength of 5% and 

Smoothness of 100%. 
 
The sand texture and parameters defined above can 
now be seen reflected on the cursor (brush). 
 
• Under Colour Usage, select Sculpt excluding 

colour. 
 
The yellow primary colour assigned earlier will be excluded in the 
sculpting process. (In this case the background). 
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• With the left mouse apply the texture to the mountain region. 
 

 
 
The sand texture is applied to the mountain region. The background was not modified as it 
was excluded as a colour. 
 

• Toggle the Colour Shade  to see the results without the bitmap 
applied. 

 

 
 

• Open the relief tree.rlf using the Relief layers Toolbar.  

• Select Toggle Visibility for the tree relief layer  (switch off from view) 
 
This new tree relief will be used in the next sculpting task as the ‘brush’. 
 
• Re-select the mountains relief layer to ensure it is active. 
 

• Select the sculpting tool Deposit.  
 
• Select tree from the Tool Settings pull down 

menu. 
• Select a Diameter of 100mm, Strength of 70% 

and Smoothness of 100%. 
• Select Ignore for the Colour Usage. 
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• Select Merge for the Relief Combine Mode. 
 
• Single mouse click to add a tree in front of the mountains. 
 
• Repeat this process to create an entire row of trees along the mountains 

as shown below. 
 
 
 
 
 
(Try to use different 
Diameters, Strengths and 
Smoothness values to add 
depth) 

 
 
 
 
 
 
 
 
 
 

• Open the bitmap grass. jpg from the Bitmap layers toolbar.  
 
• Ensure the scaling is set to Fill 

before selecting Open.  
 

• Select Create Relief Layer (from Image).  
 
• Enter a New Height of 1mm and then OK 
 
• Highlight the mountains relief layer (to make active) and then Create 

Bitmap Layer.  

• Toggle the Colour Shade ON  in the 3D View. 
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• Select to highlight the Grass relief layer (make active) 
 

• Select the sculpting tool Erase.  
 
• Select a Diameter of 100mm, Strength of 70% and Smoothness of 

100%. 
 
 
 
• Remove all areas of grass 

above the mountain as 
shown. 

 
All areas removed are reduced to the zero 
plane. This can be confirmed by 
switching off the z plane from the 3D 
view.  
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• Ensure only the mountains and trees relief layers are switched on.  
 

• Change the combine mode for the grass layer to Merge High.  
 

• Select Relief clipart library  from the Assistant tab or Reliefs pull down 
menu. 

• Select Animals under the Libraries drop down menu. 
• Select Deer and Scale it to 50%, position it at the left side of the grass, set 

a Start Height of 2mm and select Merge Highest. 
• Select Paste and then Close. 
 

 
 

• Select the sculpting tool Transfer.  
• Select a Diameter of 70mm, Strength of 50% and Smoothness of 100%. 
• Hover over the Deer’s head and with the shift button pressed, single left 

mouse click. 
• Move to the right side of the grass area  
• Hold down and move the left mouse button to create/transfer a new deer. 
• Toggle the Colour Shade OFF in the 3D View to view the results. 
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Face Wizard 
 
The Face Wizard simplifies the side profile of a face picture file to be used for generating a 
3D Relief. Ideally, the picture should have a clear background and generally be of good 
quality. The Face Wizard will guides the user through this process, finishing up in Sculpting 
mode to allow fine changes to be made. 
 

Face Wizard Hints 
 
The Face Wizard automatically produces a face, but manual Sculpting Smoothing and 
Smudging can be used to produce a more defined image. Once the Relief is produced you can 
use sculpting many times to generate the desired image. 
 
To start the Face Wizard, you must be aware of the following details: 
 

1. Photo must be well lit to show up the detail. 
2. Resolution needs to be at least 4MB pixels. 
3. When picking Nape of neck, pick under the hair if the hair is long. 
4. Ears generate an angled plane and merge high. Smooth over the join. 
5. Glasses sketch in vector, use angled plane and get the height merged just below the 

overall height. 

Face Wizard exercise 
 
• Select File – Close Model. 

• From Other Features select  
 

 
 

• Select Open Photo,  then open woman.jpg from: 
D:\users\training\ArtCAM Data.  
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The Step 2 of the Face Wizard appears. Note: If the wizard 
is not visible, then ensure the Toolbox Tab is activated by 
right-mouse selecting the grey border.   
  

 
 
A Polyline needs to be created to select the area where the 
Relief is to be generated. A saved polyline can be imported, if 
required.   
 
Note: When creating the Polyline, make sure you pick just 
inside the face because any part of the background can produce 
a spike at the edge of the Relief. 
 
 
 
 
 
 
 
 
 

 
 

• Select .  
• Select points around the head to define the profile as shown. 

 
 
 
 
 
At this stage, it does not matter if you make a mistake when 
clicking as the Polyline can be changed after creation by using 
Node editing. 
 
 
 
 

 
 

• Select Close Vector - Move End Points.  

• Use Node Editing  to make any final adjustments to your Polyline. 
 
• Select Next.  
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Step Three of the Face Wizard appears and indicates where 
to pick the two locating points for this command. This tells 
ArtCAM which way the relief if facing (to the left or right) 
and also where the main features are. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• With the left mouse button, Drag and drop the crosses  onto the 
corresponding areas indicated on the image. 

 
 

 
 
 
Step Four allows you to set the actual Relief and Model 
Dimensions, which may be different to the initial picture.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Under Head Dimensions, accept the Width and Height values. 
• Under Model Dimensions, change the Width and Height to be 120. 
• Select Next.  
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The Relief is generated. 
 
• Close the form to complete the wizard. 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Select Colour Shade  from the 3D view toolbar. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
• Apply suitable Sculpting Tools to complete 

the model. 
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12. The Toolpath Options 

Intoduction 
 
ArtCAM can produce a variety of machining strategies on the Relief.  The machining set up 
and strategy commands are accessed from the Toolpaths tab in the Project tree or by 
activating the Toolpath’s fly out panel. The toolpaths that are generated are stored within the 
ArtCAM model and can easily be edited. To drive a specific machine tool one or more 
toolpaths are output as a post-processed file translated to the format of the relevant 
controller. 

 

Toolpaths page 
 
The Toolpaths page is segregated into four main categories - Toolpath Operations, 2D 
Toolpaths, 3D Toolpaths and Toolpath Simulation. 
 

 
 
 
When a Toolpath is calculated it will be displayed in this upper 
area of the Toolpaths page. The Toolpath Names can be selected 
for Toolpath Simulation, Toolpath Operations or to re-opened 
for editing. 
 
 
 
The Toolpath Operations area contain operation including Save 
(to post process), Delete, Tool Database, Material setup and 
creating machining templates. 
 
 
The 2D Toolpaths section contains commands to generate 2D 
Toolpaths directly from Vectors. 
 
 
The 3D Toolpath section contains commands to generate the 
toolpaths over the 3D Relief. 
 
 
The Toolpath Simulation section provides controls for viewing 
Toolpath animation and material removal. 
 
Toolpath Parameters allows changes made to the selected 
Toolpath Parameters such as Tool number. 

                                                                 Issue ArtCAM Pro 2010                                                               12.1 



12. Toolpath Options                                                                              ArtCAM Pro 

 
It may be required to modify the origin of the model to a position more appropriate as a 
machining origin. This is achieved by inputting suitable X Y Z values in the 

 Set Model Position dialog box.  
 

 
 
This can be accessed from the top drop down menu Model > Set position. 
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13. Machining a Relief 

Teddy Bear Example 
 
The following example takes the user through the complete process of Machining a Relief.  
For the benefit of Training, a number of strategies and functionality will be covered. It is 
therefore not necessary that these methods will apply to all types of examples.  That will 
depend on user experience, type of machine, materials used and ultimately the type of 
component being manufactured. 
 

• Select Open Model.  
• From: D:\users\training\ArtCAM Data, select the model machine-ted.art 
• Select File > Save As  
machine-ted.art in: D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 

 
 

 
The following Relief appears in the 3D 
View window. 
 
Before generating any Toolpaths, the 
Material Setup is recommended. This can 
be accessed from the Toolpath Operations 
area or from within the Toolpath strategy 
itself.  
 
 

 
• Activate the Toolpaths Panel,  and then select Setup 

Material  from the Toolpath Operations tab. 
 
 
 
The Material Thickness allows you to input the 
thickness of the material to be machined. The 
current relief height is also displayed (5.115). If 
the Material Thickness is greater than the Relief 
Thickness, a value for top or bottom offset can be 
entered.  
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A suitable Z position for the Relief within the material is set here, allowing the user to 
position the Relief within the material as required. The X Y dimensions of the material are the 
same as the initial model setup. This can be changed as described in the previous chapter from 
the top menu Model > Set Position. 
 
 
• Enter a Material Thickness of 6mm. 
 
With a Relief height of 5.115mm, this provides a total of 0.885mm offset.  
 
• Set a Top Offset of 0.25mm. 
 
As shown, this will now result in a 0.635mm offset (platform) at the bottom of the teddy bear 
after machining. 
 
• Ensure that the Material Z Zero is set to the top. 
• Select OK. 
 
 
 

 
 
The material is displayed in blue 
around the Relief in the 3D View. 
 
The machining origin is displayed by 

switching on the Origin icon  
located at the top of the 3D Window. 
 
 
The 0.635mm offset at the bottom of 
the block is also displayed. 
 

 
 
 
 
 
 

•  From the 3D Toolpaths area, select Machine Relief.   
 
 
 
The Machine Relief page appears. 
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The Machine Relief form allows both the Roughing and Finishing operations to be defined 
here.  
 
The basic areas are summarised below but will be discussed in greater detail at each stage. 
 
 

 
Area To Machine – this either applies to the Composite 
Relief, the area within the Selected Vector or an 
Automatic Boundary. 
 
 
Finishing Options – allows the Finishing tool, cutting 
strategy and angle to be defined here.  
 
Roughing Options – allows the Roughing tool, cutting 
strategy and angle to be defined here. The Z slices 
(thickness of each cut) is also defined here. 
 
Lead In Moves – For harder materials, this option is 
used to apply a ramping move of the tool into the 
material instead of the default vertical plunge. 
 
Safe Z, Home – Sets the safe Z height (rapid move) and 
Start/End position of the tool. 
 
Material Thickness – This can be defined here or as 
shown previously. 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
When a Tool is selected for the Finishing operations, a 
number of machining strategies (for cutting) are 
available. These will be summarised below. 
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 Raster - Creates the strategy along one direction. The default angle of 0 degrees 
specifies the X direction (therefore angle of 90 degrees would change to a Y direction 
cutting direction) 
 

 Raster in X and Y - Repeats the above strategy in both X and Y direction. 
 

 Spiral - Creates a spiral strategy limited by the model. 
 

 Spiral in a box - Creates a spiral strategy trimmed to the model. 
 

 3D Offset - Follows the outer contour offsetting the Toolpath with a Stepover 
relative to the 3D form. 
 

 3D Offset Spiral - Same as 3D Offset but creates a spiral instead of a stepped 
offset. 
 
 
The form will now be completed to Machine the Teddy Bear example. 
 
 

• Select the Area to Machine as Whole Relief.  
 
Note: Whole Relief defines the complete model page and not just the Relief itself. Machining 
can be restricted by using the alternative options of Automatic Boundary or Selected 
Vector.  
 
• Change the Tolerance to 0.01 
 

 
Tolerance determines how accurately a cutter path 
follows the true shape of the relief, the actual value 
being the maximum permissible deviation from the 
relief form.  
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• In Finishing Options, select  to launch the Tool Database. 
 
 

 
The default Tool Database contains a large 
selection of tools and associated parameters for 
a variety of materials. The selection can be 
modified, deleted, or added to by the user as 
required. 
 
You can also have access to the Tool Database 

by selecting the icon  in the Toolpath 
Operations Tab. 
 

 
 
 
• By selecting the  sign next to the names, 

Browse to Metric Tools > Aluminium > 3D 
Finishing > 

  
 
• Select the Ball nose 3mm. 
 
 

 
When a tool is selected (highlighted) in the 
left hand window, the tool data and 
description is displayed on the right-hand side 
of the form.  
 
Individual tools can be Editied, Deleted or 
Copied.  
 
New Groups and Tools can also be created 
for customisation. 
 

 
 
 
• Press Select on the form to accept the 3mm Ball Nose as the finishing 

operation tool. 
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The 3mm Ball nose tool and its parameters are now loaded into the Machine Relief form. 
 
 

 
 

• Select the down arrow  to reveal the default settings for the selected 
tool. 

 
 
The default tool parameters (for Aluminium 3mm Ball 
Nose) are shown. Changing values in this form do no 
affect the original tool stored in the database. 
 
The Stepover is the distance between passes. 
  
The Stepdown is the incremental depth of cut (slices). 
 
A Tool number is essential if outputting to a machine 
tool fitted with an automatic tool changer. 
 
 

 
• Change the Stepover to 0.5mm. 
 
• Leave the Stepdown as the default 1.2mm. 
 
• Ensure the Raster strategy is selected and change the Angle to 45 

degrees. 
 
• Enter an Allowance of 0.25mm. 
 
 

 
The Material Allowance is the specified thickness of 
material that is left on over the actual relief when the 
toolpath is created. 
 
 

 
So based on the above figure, 0.25mm of material will remain on the relief after machining 
has completed. This can be therefore regarded as a semi-finish, where a final tool (to be 
calculated later) will complete the finishing with an allowance of zero. 
 
The advantage of running a Semi Finishing toolpath is that it removes the steps left by the 
previous Roughing Pass, leaving a more consistent material removal rate for the final 
finishing operation. 
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 The Roughing Tool (first operation) will now be defined. 
 
 
Roughing will remove the excess material from around the Relief up to the specified 
Material Allowance and Tolerance values. For efficiency, a relatively large tool is generally 
used for this operation. Roughing splits the Material into Z Slices and performs the selected 
Area Clearance strategy (Raster or Offset) on each one. 
 
 

• In Roughing Options, select  to launch the Tool Database. 
  
 
 
• Browse Metric tools, Aluminium, Roughing and 

2D Finishing and then select End Mill 6mm. 
 
• Select the tool. 
 
• Select the down arrow  on the End Mill 6mm bar. 
 

 
 
 
 
As before, the Feed Rate, Plunge Rate and Spindle Speed 
are based on the tool manufacturer recommendations but can 
be adjusted to suit the machine tool, and material used and 
how rigidly it is clamped down.  
 
A unique Tool Number value must be input if the toolpath 
is for a machine tool with an automatic tool changer. If not, 
the value can be left as 1. 
 
 
 
 
 
 

 
• Change the Stepover to 4mm. 
• Change the Stepdown to 1mm (this will be used for calculating the Z 

Slices). 
• As before, leave the default Feed Rate at 20mm/sec, Plunge Rate at 

6mm/sec, Spindle at 15000 r.p.m, and Tool Number as 1. 
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• Select Apply in the Z slices area 
 
 
On clicking the Apply the number of Z slices (depth 
of each cut) is automatically calculated. The automatic 
figure of 5 slices each at 0.963mm, was calculated 
from the tool Stepdown (set as 1mm), Distance to 
bottom offset and Allowance. 
 
 
Start/Surface Z at 0 (this is the initial height from where the first Step Down value will be 
subtracted). 
The Last Slice Z at -4.815 defaults to the height of the Material Allowance above Relief 
base level. This value can be modified upwards to leave more material on the base level if 
required. 
 
These values can be customised to suit (e.g if a thicker base is required) by altering the Tool 
Stepdown value, Material thickness, or by unticking the  box and entering 
suitable settings. 
 
• Leave the values as calculated automatically. 
 
 
The next stage is to select a suitable Strategy from either 
Raster or Offset. 

 

Raster Roughing   
 

 
With the Raster strategy, the tool moves across 
the Z Slices in parallel, straight line moves 
separated by the Stepover distance. The 
toolpath is automatically limited away from the 
relief by the tool radius plus the Material 
Allowance, as shown. 
 

 
 
 
The Raster process on its own tends to leave 
steps around the Relief. If required these can be 
removed by applying a Profile Pass either 
before (First) or after (Last) the Raster moves. 
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Offset Roughing 
 

 
With the Offset strategy, the tool moves are 
offset inwards from the shape of the Complete 
Relief or limiting Vector, and outwards from 
the shape of the Relief contour. Individual 
tracks are separated by the Step over distance. 
 
 
 

 
• Ensure the Raster strategy is selected with an angle of 0 degrees. 
 
 
Selecting a profile will Add a profile ‘clean up’ pass either before, during or 
after each Z slice is machined. In this example the Z Slices will be machined 
using a Raster strategy without the addition of a Profile Pass. 
 
• Do not select a Profile Pass. 
 
 
The default Angle: 0 (along X) for the Raster strategy can be changed if required. 
 
 
The cut direction of the tool can be selected here from either Conventional or Climb Milling. 
 

 
 
In Conventional Milling, the teeth of the tool meet the block of material at the bottom of the 
block. With this action, the teeth of the tool slide along until sufficient pressure builds up to 
break through the material surface. 
 
In Climb Milling, the teeth of the tool meet the block of material of material at the top of the 
cut, at the thickest part of the cut.   
 
Climb milling often provides a better finish, permits greater tool feed rates and prolongs the 
life of the tool. 
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• Leave the cutting direction as both. 
 
• Ensure the Allowance is 0.5mm.  
 
As discussed earlier, this will leave 0.5mm of material after machining. The semi-finishing 
toolpath will then reduce the material from 0.5 to 0.25mm. Then finally zero on the final 
finishing strategy. 
 

• Leave Add Ramping Moves unticked.  
 
 
Ramping Moves are applied to avoid plunging, especially where harder materials are being 
machined. If Add Ramping Moves the user has access to a selection of ramping options to 
control the Angle, Length, and incremental Height of ramp moves. 
 
 
• Select the down arrow  on the Machine Safe Z and Home bar. 
• Set Safe Z at 15 and the Home Position as X0 Y0 Z15. 
 
 
 

 
 
 
 
 
Safe Z is the user defined height in Z above the material where the tool can safely perform 
rapid moves to and from plunge positions.  
 
Note: do not forget to consider the heights of clamping and fixture components, if applicable. 
The tool Home Position defines the Start (1st move) and End (last move) of the toolpath. It 
is not permitted for the selected Z value that is less than the Safe Z value. 
 
 
• The Material has already been defined hence there is no need to open 

Setup.  
 
• Leave the default name for the Toolpath (Machine Relief) or enter a 

suitable one. 
 
• Select Calculate Now to commence the toolpath calculation. 
 

13.10 Issue ArtCAM Pro 2010 



ArtCAM                                            13. Machining a Relief 

 
The Toolpath can be calculated Now or Later. 
When the option Later is chosen it will save the 
uncalculated toolpath until the Batch Calculate 
option is selected from the toolpaths menu. 

 
Several unprocessed Toolpaths could be Batched ready to be calculated at a later time.  
 
During calculation, a progress bar will show the current 
percentage completed. 
 
 
 
• Upon completion, close the machine Relief form  
 
The 3D view, illustrates the calculated cutter paths. 
 

 
 
 
The generated Toolpath components are colour coded 
to assist with both visualisation and identification for 
post-processing.  
 
Cutting Feed Rate moves are Red, Safe Z rapid 
moves are Dark Blue, and Plunge/Ramp moves are 
Pale Blue. 
 
 
 
 

 
 
The Toolpath appears at the top of the Toolpaths 
page. The Toolpath can be shown or hidden by 
ticking or unticking the relevant Show in - 3D 
column boxes. 
 
 

 
 
The Roughing process has created two toolpaths. The second toolpath (labelled LP – Last 
Pass) is a small incremental slice (left over by the main roughing process) that is remove in a 
single and final stage. This is used to improve the finish of the toolpath.  
 

The Objects To Draw icon  at the top of the 3D View, allows the user to toggle the 
visibility of all entity types (not just machining toolpaths).  
 
• Click Objects To Draw  on the 3D View Toolbar. 
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You can toggle between different objects by clicking on 
them and by selecting Apply to display the selected items in 
the 3D View. Currently, only the Vectors are undrawn. 
 
 

 
• Highlight only the End Mill 6mm Roughing toolpath and select Apply. 

 
 
 
The Initial Roughing Toolpath is now the only 
displayed item. 
 
 
 
 
 
 
 
 

 
• Highlight only the (LP) End Mill 6mm Roughing toolpath and select 

Apply. 
 

 
 
The Final Last Pass (LP) Roughing Toolpath is now 
displayed. 
 
 
 
 
 
 
 

 
 
• Highlight all objects as before, followed by Apply. 
• Select File and then Save.  
 
 
 
The Toolpaths have been saved into the current 
ArtCAM model. 
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If the Toolpaths require Editing, double left mouse clicking on the toolpath in the Toolpaths 
window will reopen the Machine Relief form.  
 
Any parameter can be changed and recalculated to update. Note: if a new, separate 
Toolpath is required, edit the Name to be different from the original. 
 
 
Certain parameters can also be quickly changed by highlighting the 
individual toolpath and then selecting Toolpath Parameters at the 
bottom of the Toolpaths fly out menu. Select Apply to update. 
 
 
 
 

Simulating the Toolpaths 
 
Toolpath movement and material removal can be simulated in the ArtCAM 3D View. 
Options are available in the Toolpath Simulation Tab at the bottom of the Toolpaths fly out 
menu. 
  

 
Options available in this menu are simulate, reset, 
delete, export and import the simulation.  
 
The shading can also be changed to reflect the final 
material. 
 

 
• Select and Highlight the Machine Relief Toolpath. 
 

If Simulate Toolpath is selected,  all individual Toolpaths (within the Toolpath) will 
be simulated in sequence.  

• Select Simulate Toolpath.  
 

 
The following form will be displayed: 
 
Relief Dimensions: shows the overall dimensions of the 
relief. 
Simulation Block Dimensions: gives the size of the block. 
This should be at least as big as the minimum and 
maximum height of the relief plus any height (or depth) of 
the engraving features.  
Simulation Relief Resolution: specifies the quality of the 
image that you require. The lower the resolution, the greater 
the speed of calculation. 
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• Select Standard from the Simulation Relief Resolution area. 
• Use the other default settings and select Simulate Toolpath. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The three toolpaths in the sequence listed are simulated on screen and the final result shown 
(after finishing operation) 
 

• Select Reset Simulation to reset the block.  
 
The toolpaths will be simulated individually to verify the results after each stage. 
 
 
• Select and Highlight the Machine Relief Toolpath. 
 

• Select Simulation Control bar.   
 
 

 
 
With this option the highlighted tool is drawn (End 
Mill 6mm first), along with a control panel to 
control the speed of the simulation. 
 

For example, Selecting  will simulate at 
normal cutting speed. 
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• In this case, select Run at Max speed to next retract.  
 
 

 
 
The simulation stops (and retracts) at the end of 
the first Toolpath End Mill 6mm Roughing. 
 
 
 
 
 
 
 

• Select Run at Max speed to next retract  again. 
 

 
 
 
The simulation stops (and retracts) at the end of 
the second Toolpath (LP) End Mill 6mm 
Roughing. 
 
 
 
 
 

• Select Run at Max speed to next retract  again. 
 

 
 
 
The simulation ends at the final toolpath Ball 
Nose 3mm Finishing. 
 
 
 
 
 
 
 

 
The result is a 3D model of the part machined component which also within graphics 
limitations will indicate the standard of surface finish.   
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I can be seen that an additional toolpath is required to obtain the final result. Also note the 
above result/simulation includes the 0.25mm allowance of material that was defined in the 
finishing options of the Machine Relief form. 
 
The final toolpath will calculated and will therefore have an allowance of zero. 

• Select Delete Simulation.  
 

Finishing (3D Offset) Toolpath 
 
For the initial finishing, the same 3mm Ball Nose tool will be used, but this time using the 3D 
Offset Spiral Strategy. An improved finish will be achieved by specifying a smaller 
Stepover and as discussed, an Allowance of 0.  
 
To speed up machining times, A vector will be used to limit the extent of the toolpath to be 
over the 3D Relief form and not the complete flat base area (as before). The 3mm ball nose 
will still leave excess material on internal corners but these will be picked out locally using 
the Rest machining strategy. (To be discussed later) 
 

• Switch on Toggle Vector Visibility  in the 3D view menu. 
 

 
 
A pre-defined vector outlining the Teddy bear 
is now visible. This vector will be offset to 
define a boundary to restrict the next toolpath 
calculation. 
 
 
 
 

 
 
• Select this vector and from the main Vectors pull 

down menu, select Offset.  
 
 
• Offset the vector Outwards by a Distance of 2mm. (Ensure the Radiused 

option is selected) 
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• Select View along the Z axis  from the 3D 
view menu.  

 
 
 
• Select this new offset vector. 
 
 
 

• From the Toolpaths fly out panel, select Machine a Relief  to create a 
new toolpath. 

 
 
• From the Area to machine drop down menu, select Selected 

vectors.  
 
• Ensure Inside Vector is selected. 
 
• Leave the Tolerance as 0.01. 
 

• In Finishing Options, select  to launch the Tool Database. 
 
• By selecting the  sign next to the names, Browse to Metric Tools > 

Aluminium > 3D Finishing > 
  
• Select the same Ball nose 3mm as before. 
 
• Select the down arrow  to reveal the default settings for the selected 

tool. 
 
 
• Change the Stepover to 0.05mm.  
 
This will ensure a closer and improved finish. 
 
• Leave the Stepdown as the default 1.2mm. 
 
• Select the 3D Offset strategy is selected. 
 
• Ensure the Allowance is 0. 
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ArtCAM retains the previous material and Safe Z and Home settings. 
 
• Change the Safe Z height to 5mm.  
 
This will reduce overall machining times by reducing the time spent at 
rapid speed between toolpath segments. 
 
• Leave the other options as before. 
• Change the file name to BN3-3D Offset Finish. 
 
• Select Calculate Now and close the machine Relief form. 
 
 

• From Objects to Draw,  Hide all entities apart 
from the Front Relief and the new 3D Offset 
toolpath. 

 
 
 

 
 
 
The 3D Offset with small stepover is 
displayed. The Selected vector has 
limited the machining boundary. 
 
 
 
 
 

 

• Select Simulate All Toolpaths.  
 
 
This option simulates ALL the toolpaths calculated and displayed in the Toolpaths form. 
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The final result (following the 3D offset 
toolpath) shows a significant improvement.  
 
Upon close inspection, there are areas of 
material not yet removed. (E.g. around neck and 
feet) 
 
These regions will be removed using a new 
strategy called 3D Rest Machining. 
 
  

 
• Select File – Save. 

 

3D Rest Machining. 
 
 
3D Rest Machining creates closed vectors around areas of the Relief that are out of reach to 
the tooling geometry of previously created toolpaths. A further Machine Relief toolpath 
using a smaller tool can then be applied within the vector area to locally pick out the 
remaining detail. The calculation of the Rest Machining vectors uses the simulation model 
of the previous toolpaths.  
 
 
• Reselect the previous offset vector that was 

used to limit the previous toolpath. 
 
 
 
 
 
 
 

• In the 3D Toolpaths area select 3D Rest Machining  strategy. 
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This form will identify areas by comparing the simulation from the previous toolpaths to the 
current relief. ArtCAM will then automatically create vectors to mark out the areas which 
require further machining.  
 

 
 
• Select the option Area under selected 

vectors. (The offset vector is used) 
 
• Select the option Simulating the last 

toolpath.  
 
This will use the 3D offset vector for reference 
 
• Enter a Cusp Tolerance value of 0.05mm. 
 
This height will ignore all ‘cusps’ (created from 
toolpath geometry during passes) below this level when 
identifying the areas to be rest machined. 
 
 

 
• Keep the default Layer name, Rest Machining. 
 
• Select Create Boundaries. 
 

• Activate the Vector Layers Flyout tab.  
 
 
 
New vectors have been and assigned to a new Layer 
with the name Rest Machining 
 
 
 
 
• Switch off the Default Vector Layer (by selecting the adjacent light bulb 

icon ) 
 
 
• In addition, Ensure the Bitmap Layer is also switched off. 
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The Rest machining vectors are displayed 
 
 
However these vectors will be offset outwards to provide the 
next tool a region to blend more smoothly.  
 
 
 
 
 

 
 

• With the Rest Machining vectors selected, select Offset Vector(s).  
 
 

 
 
• Enter an Offset Distance value of 0.2mm, select 

the Outwards/Right, Radiused and Delete original 
vectors options.  

 
• Select Offset then close the form. 
 
 
 
 
 
 

 
 

 
 
The Offset - Rest boundary will allow the new finishing 
toolpath to blend more smoothly over the form previously 
finished with the 3mm Ball Nose tool. 
 
It will be easier to use a copy of the previous finishing toolpath 
as the basis for the new Rest finishing strategy. 
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• Select and double click on the stored BN3-3D Offset Finish toolpath to 
open the Machine Relief form to enable editing of the settings and 
parameters. 

 
• Ensure the new Offset vectors are selected. 
 
All of the previous parameters and settings will remain the same for the new toolpath apart 
from the Tool selection and the toolpath Name. 
 
• In the Finishing Options, Change the 3mm Ball nose to a 0.5mm Ball 

Nose tool. 
 
If a 0.5 mm is not listed, then create a new Tool by selecting Add Tool on the 
Tool database form. 
 
• Change the Stepover to 0.05mm. 
 
• Change the name the Toolpath BN0.5-Finish. 
 
• Select Calculate Now and close the machine Relief form 
 
 
 
The Toolpaths are calculated within the  
Rest machining vectors. 
 
 
 
 
 
 

• Select Simulate All Toolpaths.  
 

 
 
 
Sharper detail in the corners has been 
produced by removing previously 
inaccessible regions to the 3mm Ball Nose 
tool. 
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The machining if the model is now complete. 
 
 
• Select File- Save (to update the model train-machine-ted). 
 
• Select File – Close Model. 
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14. 3D Cut Out Machining 

Overview 
 
The outside form of a model will be profile machined in stages with the 3D Cut Out profile 

strategy.  
 
This strategy follows the shape of the selected vectors and automatically compensates for tool 
radius and material Allowance.  
 
This Chapter will also introduce the application of Lead In/Out, Ramping and Bridges to 
Relief Machining 
 

• Select Open Model.  
• From D:\users\training\ArtCAM Data, select the model brooch_new.art. 
 

 
 
• Highlight Brooch_new in the Project Tree. 
 
 
 
 
The Model Information summary shows that the Relief exists 
both above and below Z0.  
 
 
 
 
• If not visible, Activate the Toolpaths fly out panel. 
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• In the 2D View, select the Outer star vector. 
 
 
 
3D Cut Out uses vectors as the basis for creating a stacked 
toolpath offsetting either Outside or Inside for the tool 
geometry and machining Allowance.  
 
Note: the Relief is not directly involved. 
 
 
 
 

• Define a material  of 13mm depth with Z 
zero at the top and zero bottom offset. 

 
 
 

• In the 3D Toolpaths area select 3D Cut Out.  
 
 
 
• Select the Profile Side as Outside. 
 
 
• Ensure Selected Vectors is selected. 
 
• Enter a Surface Z distance of 0 and a Finish Z 

distance of -13mm (depth of material) 
 
 
• Enter a Safe Z distance of 10 and a Home 

Position of X0 Y0 Z10. 
 
• Select a 3mm End Mill Tool and override the 

Stepdown value to 2mm. 
 
• Select Climb Mill as Cut Direction. 
 
• Enter the toolpath Name as EM3-3DCutout 

and select Calculate Now. 
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• Do not close the 3D Cut out form. 
 

 
         
 
 
 
The toolpath has been generated at 2mm Z 
height slices calculated using the tool 
stepdown.  
 
 
 
 
 

 

Lead in/Out Moves 
 
To provide a smoother tool move onto the component profile it is possible to apply a circular 
lead move on and off the toolpath. 
 
 
• Tick the option for Add Lead In/Out Moves to reveal the options. 
 
 
The Add Lead In/Out Moves form provides two main options, Linear or Circular Arc. 
 

 
 
• Enter a Distance of 5mm, select Circular 

Arc with a Radius of 5mm. 
 
• Select Calculate Now to update.  
 
 
 
 
 
A smooth Lead In and Lead Out Arc had been added to 
the toolpath 
 
A Ramping Move will now be added. This will instruct 
the tool to ramp down in a zig-zag or spiral motion during 
the Lead In move. 
 
Ramping is used for tools that do not cut at the base but 
only around the edges. 
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• Tick the option for Add Ramping Moves to reveal the options. 
 

 
 
 
 
• Set the values as shown 
• Select Calculate Now to update. 
 
 
 
 
 
 
 

 
 

 
The light blue moves on the toolpath are ramping 
moves onto the profile passes. These only apply to 
the Lead In moves. At the end of the Lead out the 
tool finishes with a rapid retract to Safe Z 
followed by a rapid move to the Home Position. 
 
Ramping is essential in cases where a non-
plunging tool is being used. 
 
 
 

 

• Select Simulate Toolpath  to view the results graphically. 
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• Close the 3D cut out form. 
• Select File- Save As. 
 
•  Enter the File name as BroochMachineTraining in 

D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 

Creating Bridges 
 
In some applications it is required to profile around a component within a block of material 
leaving location lugs to keep it in position until such time as it is required to break it free. 
 
To create suitable location lugs, the Profile Options from the 2D Toolpaths area are 

utilised.  
 
 
• In the 2D View select the profile toolpath, as shown in the image below. 
 

 
 

• In the 2D Toolpaths area select Profile Options.  
 
• If not visible, Select F6 to activate the Tool Settings fly out Panel. 
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• Select Constant Number from Add 

Bridges to Profiles. 
• Enter Number 4. 
 
 
 
• Input a Bridge Length of 5 and a Bridge 

Thickness of 3 with 3D Bridges selected 
 
• Select the Create Bridges tab at the top. 
 
 
 
 
 
 

 
 
 
The four Bridges are added to the 3D Cut Out 
toolpath. 
 
Note: Individual Bridge lengths can be edited by 
dynamically dragging on a square marker at the 
end of a Bridge preview. Dragging the ‘centre 
cross’ moves its position. 
 
 
 
 
 

 
• Close the Profile Options form to exit. 
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The 4 Bridges are formed with a triangular 
movement in the Z Plane. 
 
 
If 3D Bridges was unticked, then the 
Bridges are formed with a rectangular 
movement in the Z Plane. 
 
 
 
 

 

• If required, Select Reset Simulation.  
 

• Select Simulate Toolpath  to view the included bridges. 
 

 
 
 
• Save and Close the ArtCAM model. 
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15. Post Processing Toolpaths 

Introduction 
 
The Toolpaths produced in ArtCAM have to be translated into a different format as an 
exported file for a specific machine tool controller. The collective name for one of these 
files is NC data and the operation is called Post-Processing which is accessed via the Save 

Toolpaths option in the Toolpaths Tab.  

 

Post Processing of Toolpaths for a Manual Tool Changer 
 
 
• Open the previously machined model. machine-ted.art 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Activate the Toolpaths fly out panel if not already visible. 
 

 
 
All toolpaths previously calculated (in chapter 13 
are listed) 
 
Use the scroll bar to view all. 
 
 
 
 

 

• Select Save Toolpaths  from the Toolpath Operations area. 
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When the Save Toolpaths form is opened all existing toolpaths are listed in the left hand 
window. Toolpaths are selected and transferred from one side to the other using the central 
Arrow buttons. 
 
                                                              
All the files in the right hand window will be included for output into a single NC data file.  
If the machine tool uses a manual tool changer then it will only be possible to include 
Toolpaths in the NCdata file that share the same cutting tool. If the machine tool has an 
automatic tool changer then any combination of the available toolpaths can be include in 
the NCdata file. (as long as the selected machine supports it) 
 
 
• Select the toolpath Machine Relief-End Mill 6mm Roughing and then the 

right Black arrow.  (to transfer it across) 
• Deselect Save files to spool Directory (You will be prompted for the 

location directory for outputting the current NCdata file). 
 
• From Machine Output, select Axyz_Arc_MM(*.nc)  
 

 
 
 
Note: this machine does not 
support an automatic tool 
changer hence only Toolpaths 
that use the same tool can be 
included in the ncdata output 
file. 
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• Select Save and browse to select C:\temp, enter a File name as Em6-

Rough-ted and select Save. 

• Select the left black arrow  (to move the toolpath back to the left 
window).  

• Select the toolpath Machine Relief-(LP) End Mill 6mm roughing and then 

the right Black arrow.   
 
• Select Save and browse to select C:\temp, enter a File name as (LP) 

Em6-Rough-ted and select save. 
 
• Repeat the above procedure for the remaining Toolpaths providing 

suitable file names. 
 
• Browse to the C:\Temp directory to see the saves toolpaths. 
 

 
  
 
All the post-processed Toolpaths have been saved outside ArtCAM and translated in the 
format required for an Axyz machine controller. These files can now transferred to the 
machine controller itself, ready for manufacture. 
 
Note: If the Toolpath is modified within ArtCAM, the above process must be repeated for 
that specific file. 
 
• Do not close the model as it is required again in the next chapter. 
 

Post Processing of Toolpaths for an Automatic Tool Changer 
 
If a Machine Tool is fitted with an Automatic Tool Changer then the control of this feature 
will be available in the Post Processor translation. 
 
If toolpaths containing different tools are passed over to the right hand window of the Save 
Toolpaths form and the selected Post Processor does not support an Automatic Tool 
Changer then a box with an error message will appear. 
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• Using the black arrow,  Transfer all the toolpaths into the right hand 
window as shown. 

 
 

 
 
 
Note: The Vertical arrows can be 
used to reorder the toolpaths for a 
single output file.   
 
 
 
 
 

 
• Ensure the same machine output file is selected as before. 
 
• Select Save to output the combined files. 
 
 

 
 
 
The operation has failed and the above error message appears. The files were unable to be 
processed for two reasons. 
 

1. The selected Machine (post processor) does not support tool changing itself.  
 
 
2. All tools are currently identified as Tool number 1.  The Tool Number is essential to 

identify the location of an individual Tool in the tool changer or carousel 
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The Tool Number can be defined in a number of ways. 
 
 

1. Entering the tool number within the defined tool of 
the toolpath.  The Toolpath must be recalculated. 

 
 

 
 
 
 
 
 
 
 
2. Entering/Editing the default tool 

number defined in the Tool database. 
 
 
 
 
 
 
 
 

3. The simplest way is to change the tool number by first highlighting the tool in the 
Toolpaths Tab. 

 

 
 
 
 
Expand  the Toolpath parameters Tab at the 
bottom of the Toolpaths Panel. 
 
 
The Tool number can be changed here and updated 
by just selecting Apply. 
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• Use any of the methods described above to assign Tool numbers as 
shown in the image below. 

 

• Select Save Toolpaths  from the Toolpath Operations area. 
 
• Move all the Toolpaths to the right hand window. 
 
• Reorder the Toolpaths as required. 
 
 

 
 
 
• Change the Machine output file to Axyz_MultiTool_Arc_MM.  
 
 
• Select Save. 
 
Note: No Error message is displayed and now allows the files to be saved as one. 
 
• Locate C:\temp and enter the File name as MachineTed and select save. 
 
 
NC code can be viewed in WordPad for analysis or editing if required. 
 
 
• Browse to the C:\Temp directory to see the saved toolpaths. 
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• Right mouse click on the Toolpath an open with WordPad. 
 
 

 
 
 
 
The outputted NC code can be viewed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                              Issue ArtCAM Pro 2010                                                                15.7 



  15. Post Processing Toolpaths                                                                                  ArtCAM  
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16. Toolpath Templates 

Toolpath Templates 
 
A Toolpath Template is a file containing one or more unprocessed machining strategies 
stored outside ArtCAM as a .tpl file. A previously stored Toolpath Template is imported 
into ArtCAM and the associated machining strategies can be then edited (if required) before 
the toolpaths are regenerated for the current model.  
 
The benefit of Toolpath Templates is that a whole set of unprocessed machining strategies 
can later be loaded into ArtCAM with all the tooling and settings already set for the user 
specific application or for a series of similar ArtCAM models. 
 
• Open the previously machined model. machine-ted.art 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Activate the Toolpaths fly out panel if not already visible. 
 
 

 
 
This ArtCAM model contains five Toolpaths, two 
of which require closed vectors to control the area to 
be machined. When a Template is Saved/Created, 
all toolpaths that exist in the model are included in 
the output file.  
 
 
 

 

• Select Save Toolpath as Template  from the Toolpath Operations 
area. 

 
 
The toolpath template is a special file type 
(*.tpl) and is stored outside of the ArtCAM 
model.  
 
It is a good idea to be as descriptive as 
possible with the template name. 
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• Select the area D:\users\training\COURSEWORK\ArtCAMPro-Jobs and 

enter the File name EM6-BN3-BN0.5.tpl. 
 

 
 
• Select Save. 
 
The template can now be loaded into a different model or, if these toolpaths have been 
deleted, they can be loaded back into the current model. 
 
 
• In the current model, Select each toolpath and delete it using Delete 

Toolpath  in Toolpath Operations. 
 
(It therefore assumes at this point, the Relief has just been created……….)  
 

• From Toolpath Operations, Select Load Toolpath Template.  
 
• Browse and Select the previously created file EM6-BN3-BN0.5.tpl.  
 
• Select Open. 
 
 

 
The Unprocessed toolpaths are displayed in thr 
Toolpaths Tab. In addition, there are no ‘display 
toolpath’ tick boxes below ‘Show in 2D/3D’ 
indicating that they have not yet been calculated. 
 
 
 

 

• From Toolpath Operations, Select Batch Calculate Toolpaths.  
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Te form appears with all of the toolpaths listed. By default all of 
the toolpaths are ticked, ready to be included in the Batch 
Calculate process. 
 
Note: If use a selected vector is specified in the toolpath page, a 
suitable vector must first be created and selected if Batch 
Calculating the template on a different model. 
 
 
 

 
 

 
 
• Select the Start tab to commence calculation of the 

toolpaths. 
 
 
 
• Close the dialog box when finished. 
 
 
 
 

 
 
All of the toolpaths have been calculated including the last two, which require the selection 
of a suitable limiting vector. As the Toolpath Template is being applied to the same model 
then the vectors will be remembered and selected automatically. If the Toolpath Template is 
applied to a different model then these toolpaths will have to be opened on an individual 
basis and suitable limiting vectors created and selected before applying Calculate Now. 
 

• Simulate All Toolpaths  if required. 
 
 
• Select File Save and then Close. 
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17. 2D Vector Machining 

Introduction 
 
For certain type of 2D components it is of no benefit to create a 3D Relief Model. For these 
applications ArtCAM Pro has a series of options to create 2D Toolpaths that are directly 
calculated from vectors.  

Forest Sign – 2D Area Clearance 
 
• Open the model Forest_Sign.art from: D:\users\training\ArtCAM Data. 
 
 

 
 
• Hold down the shift key and multi-select the Inner Ellipse, Squirrel, 
Tree, and Text vectors. 
 
 
• Activate the Toolpaths fly out panel if not already visible. 
 

• Select Area Clearance Toolpath  from the 2D Toolpaths Tab. 
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• Set the Start Depth as 0, Finish Depth as 
2mm and Allowance as 0. 
 
• Set the Final Tool Allowance as 0.25mm and 
Tolerance as 0.01mm. 
 
 
• Select the downward arrow under Machine 
Safe Z and enter a value of 20mm for Safe Z and 
X-100, Y-50 and Z20 for the Home Position. 
 
 
 
 
 
 
 
 
Although the terminology is similar to Relief machining, the following information was 
entered. 
 
Start Depth – is the height from where the Stepdown is calculated. 
 
Finish Depth – is the maximum depth for machining to occur. 
 
Allowance – is the amount of 2D stock remaining on the vectors for the final tool. 
 
Final Tool Allowance – is the amount of 2D stock remaining for all except the final tool 
(normally used to produce a better surface finish) 
 
Tolerance – the toolpath will create a finish to within 0.01 the original vector. 
 
Safe Z – is the height at which rapid moves across the component are permitted. 
 
Home Position: specifies the coordinates of the Start and End point of the toolpath. 
 
 
•  Select Add from the Tools List.  
 
• From the tool database Wood or Plastic > Roughing and 2D Finishing 
area and load in both the End Mill 6mm and the End Mill 1.5mm tools. 
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The 2D Area Clearance strategy allows multiple tools to be selected.  
 

 
The selected tools are displayed. The adjacent 
arrows can be used to change the sequence if 
required.  
 

 
The Tools List contains two different End Mills. When the toolpath is calculated, the larger 
6mm End Mill is used first to perform the main 2D Area Clearance machining. Any 
subsequent, smaller tools in the Tools List will only operate locally in areas that are out of 
reach to the previous tool (i.e. Rest Milling). 
 
• Select a Raster strategy and leave the angle at zero (X=0). 
 
Note: There are two options available for 2D Area Clearance machining strategies, Raster 
which steps a linear cutterpath backwards and forwards across the component or Offset 
which steps the cutterpath parallel to the selected vector(s).  
 
• Leave the Independent Finish Depth option unticked. 
 
This allows the option to specify an Independent depth for a particular tool.  
 
 
• Set up the Material to have a Thickness of 10mm, 
the Z Zero should be at the top. 
 
• Enter the Name EM6EM1_5-AreaClear. 
 
• Select Calculate Now. 
 

 
 
 
The 2D Area Clearance toolpaths will appear as shown above. As the primary tool (End 
Mill 6mm) had a default Stepdown value of 2.4mm, all of the machining has been 
performed at the single depth of –2mm. If the above Stepdown value were 1mm then the 
machining would have been performed at depths of both –1mm and –2mm. 
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• Close the 2D Area clearance form. 
 
The Toolpaths are listed in Toolpaths fly out panel. 
 
 

 
The Toolpaths window now contains two named 
toolpaths, which by default are also displayed in both 
the 2D and 3D views – by using the check boxes. 
 

• In the 3D view, select the Isometric View.  
 
  

  

 
 

• Select Simulation Control bar  from Toolpath Simulation. 
 
 
 

 
With this option the highlighted tool is drawn 
(End Mill 6mm first), along with a control panel 
to control the speed of the simulation. 
 

For example, Selecting  will simulate at 
normal cutting speed. 
 

 
 
 

• In this case, select Play Simulation at Fast speed.  
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The End Mill 6 mm is simulated. 
 
This toolpath has machined the inner form 
leaving a 2D stock of 0.25mm to be finished by 
the End Mill 1.5mm toolpath. 
 
 
 
 

 

• Select Play Simulation at Fast speed.  
 
 
 

 
 
 
The End Mill 1.5 mm toolpath has 
successfully rest machined the remaining areas 
inaccessible to the previous cutter and removed 
the final 0.25mm stock allowance. 
 
 
 

 

Forest Sign – 2D Profiling 
 
 
 
• Select the 2D View and 
select the Outer Ellipse vector. 
 
 
 
 
 
 
 
A 2D Profiling strategy will be used to drive the tool around the outside of the sign. 
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• Select Create Profile Toolpath  from the 2D Toolpaths Tab. 
 
 

 
A Profiling toolpath can be generated to the defined depth, on 
the Inside, Outside or Along a closed vector. There is also the 
option to apply a Climb Mill or Conventional direction of cut. 
For an open vector, Inside will offset the toolpath to the right 
of the vector direction whereas Outside will offset the 
toolpath to the left of the vector direction. 
 
The depth of cut for each profiling pass is defined by the 
tool’s stored parameters, for example if the tool has a step 
down of 2mm maximum, it would take 5 profiling passes to get 
down to a total depth of 10mm. 
 
With a 2D Profiling toolpath the option is available to 
approach required profile with a horizontal, arc Lead In and 
Lead Out. This would result in a tool plunge move occurring 
away from the profile followed by a smooth, tangential 
transition onto the actual tool track.  
 
 
 
 
 

 
 
• Select Profile side as Outside. 
 
Offset Allowance specifies an offset distance to the vector. 
 
Final Pass Thickness allows a ‘skin’ of material removed only on 
the last pass.  
Final Pass Allowance as above leaves a skin of material but in the Z 
Height only. Also is removed on the last pass. 
 
 
• Leave the above settings as zero. 
 
 
• Select a Start Depth of 0, Finish Depth of 10, Allowance of 0 and a 
Tolerance of 0.01mm. 
 
• In Profiling Tool, select the Select button and load in the same 6mm End 
Mill that was used earlier in the 2D Area Clearance operation. 
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When 2D Profiling around a component, a superior finish is achieved for most materials if 
the direction of travel is the left of the vector (Climb Milling). There are however a few 
materials (certain plastics) where a superior finish is achieved if the direction of travel is the 
right of the vector (Conventional).  
 
• Select Climb at the Cutting direction. 
 
• Leave the same (as before) Material Thickness, Safe Z, and Home 
position. 
 
• Enter the Name EM6Profile. 
 
• Select Calculate Now. 
 
 
 
 
 
The 2D Profiling toolpath has been 
generated outside the Outer Ellipse. 
 
 
 
 
 
• Close the Profiling form. 

• Select Simulate Toolpath.  
 

 
 
 
The simulation steps the 2D Profiling pass 
down to a total depth of 10mm. If it is 
required to keep the sign attached to the outer 
material then location lugs (Bridges) can be 
applied retrospectively along the toolpath.  
 
This will be shown next. 
 

 
 
 
• Select File - Save As TrainForestSign.art in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 

 
• Do not close the model. 
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• Select Profile Options  from 2D Toolpaths. 
 
 
 
• As described in chapter 13, Create four suitably 
positioned 3D Bridges of Thickness 3mm and Length 
4mm. 
 
 
 
 

• Reset  and Rerun  the simulation to view the added bridges. 
 
 

 
 
Further 2D machining strategies will be applied to this example. 
                                                                                                    
• Do not close the model. 
 

Bevel Carving 
 
The 2mm high text ‘FOREST’ on the sign will have a 1mm chamfer added by using the 2D 
Toolpaths option called Bevel Carving.  
The process requires the user to input a Bevel Carving Tool. The tool dimensions and/or 
stored values of Stepdown and Stepover will determine if the chamfer is machined as a 
series of ‘stepped passes’ or in a single ‘pass’ 
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• In the 2D View select the Text item 
‘FOREST’. 
 
(Note:View shown is with toolpaths switched 
off) 
 
 
 

• Select Bevel Carving  from the 2D Toolpaths Tab. 
 
 
 
• Enter a Start Depth 0, Bevel Max Depth 1, Finish 
Depth 2mm. 
 
Bevel Depth is the max depth the carving tool will reach. 
Wall height is the height of the profiled part of the carving which 
is zero, if no profiling tool is selected. 
Finish depth is entire depth of the whole cutting operation 
 
• Enter Allowance of 0 and a Tolerance of 0.01mm. 
 
• Enter a Safe Z of 20 and a Home Position of  
X-100 Y-50 Z20. 
 
• Select Centreline. 
  
This determines the max width of path to engrave. 
 
• Select a V-Bit 32mm 120 degrees Carving Tool 
and a 1.5mm End Mill Profiling Tool. 
 
• Set a Climb Mill Cut Direction. 
 
• Set up the Material to have a Thickness of 10, the Z Zero should be at 
the top. 
 
• Enter a Name as Bevel_Carving. 
 
• Select Calculate Now. 
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The toolpaths can be seen in the 3D view.  
 
Note: view is shown with other toolpaths 
switched off. 
 
 
 
 
 
 
 
 

 
• Close the Bevel Carving form. 
 

• Select Simulate All Toolpaths.  
 
 

 
 
The 1mm chamfer can clearly be seen on 
the embossed 2mm high text. 
 
 
 
 
 
 
 
 

 
 
 
• Select File - Save to update the model saved earlier. 
 
 
• Select File - Close Model 
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V Bit Carving 
 
The following example illustrates the V-Bit Carving strategy. 
 
• Select Create New Model and Enter a Width and Height of 100mm. 
• Set the resolution to 2004 x 2004 points and origin in the centre. 
 
• From the top pull down menu, Select Vectors - Import and Open the file:  
 
D:\users\training\ArtCAM Data\V-BitCarvingVectors.eps 
 
 
 
 
 
 
 
 
 
 
 

• Ungroup  (or Ctrl+U) and then select the Vectors.   
 

• Select V-Bit Carving  from the 2D Toolpaths Tab. 
 
• Leave the Start Depth as 0. 
• Ensure Tolerance is set as 0.01.  
 
The maximum permissible depth for machining to occur can be set 
by selecting Limit tool maximum depth and specify a Maximum 
Depth value. 
 
• Select a V-Bit 32mm 90degrees Carving Tool from 
Wood or Plastic – V-Carving, and change the Stepover 
to 1mm and Stepdown to 3mm. 
 
• Set the Safe Z as 20mm and the Home Position as 
X-100 Y-50 Z20.  
• Enter a Material Thickness of 20mm and set the 
Material Z Zero is at the top of the block. 
• Enter a Name of VBitCarving and select Calculate 
Now. 
• Do not Close the form. 
 

 Issue ArtCAM Pro 2010                                                                 17.11 



17. 2D Vector Machining                                                                                 ArtCAM  

• Simulate  the calculated Toolpath. 
 
 

 
 
 
The toolpath is calculated creating ‘V’ shaped 
recesses inside or between pairs of selected 
vectors and text. The maximum depth of the 
recesses is currently unlimited but the tool does 
perform an area clearance at incremental depths 
equal to the specified Tool Stepdown value. 
The Area Clearance can be removed by 
inputting a suitably high value for Stepdown. 
 
 
 

 
 
• Edit the Tool Stepdown to 10mm.    
• Calculate the Toolpath again. 
•  Do not Close the page. 

 
 
 
 
The toolpath has created the same end result, 
but without performing area clearance at 3mm 
incremental depths (the tool Stepdown is now 
10mm). 
 
 
 
 
 

 
 
 
• Select File - Save As and save the model with the File name VbitCarving 
in: 
 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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18. Engraving & Scribe Lines 

Introduction 
 
Smart Engraving allows you to input a selection of Roughing (End Mill) and Engraving 
(V Shaped) tools, which create a series of efficient toolpaths within the defined vector 
selection ultimately producing the required engraved form. Different machining parameters 
and tool settings can be applied to each toolpath from within the Smart Engraving options. 
For small detail it is possible to run Smart Engraving with one ‘V’ shaped tool.  
 
If more than one tool is selected, Smart Machining is performed. This is the strategy where 
smaller tools will only machine the areas previous tools were unable to reach. If conical tools 
are used, options to enable 3D corner sharpening moves are available. 

Smart Engraving Exercise 
 
• Open the model arch.art from: D:\users\training\ArtCAM Data. 

 
 
 
 
 
The Smart Engraving options provide for finishing of 
sharp internal corners for the finishing tooplaths using the 
‘V’ Bit Cutters.  
 
The selected vector is the top edge of the detail. The 
option to offset the End Mill for the Engraving Tool (it 
leaves additional material on) is used to give the V-Bit 
finish tool some material on each side to cut out, to 
balance the loading on the V-Bit tool. 
 
 
 
 
 
 
 

 
• Select only the Inner feature vector as shown above. 
 

• Select Smart Engraving  from the 2D Toolpaths Tab. 
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• Enter a Start Depth of 0 and a Finish Depth 

of 5mm and Tolerance as 0.01. 
 
• Select the option Vectors are on surface. 
This assumes the vectors lie at the top of the surface. 
Unticking the box assumes the vectors lie at the bottom.  
 
• Select Offset End mills for Engraving 

tools. 
The End Mill tool will be offset to ensure the engraving 
tool will be able to machine an angled wall. 
 
•  Set Safe Z as 5 and Home Position X0 Y0 

Z5. 
• Add a 6mm and 3mm End Mill tools, along 

with a Small V-Bit 12mm 90 Degree tool.  
Note: the V-Bit tool will have to be copied and edited 
within the Tool Database from an existing stored tool. 
 
• Enter an Allowance of 0.1mm only on the 

End Mill 6mm tool. 
 
Note: Several parameters can be defined independently 
for the specific tool selected (highlighted) in the form.  
 
• Select Do corner Sharpening only for the V-

Bit 12mm 90 degree tool. 
 
• Set the Material Thickness to 25.4mm with 

the Z0 origin at the top. 
 
 
 
The machining calculations will take the vector to be the top edge of the chamfered detail.  
 
 
• For the End Mill 6mm tool set the tool Stepover to 4mm and the 

Stepdown to 5mm. 
 
• For the End Mill 3mm tool set the tool Stepover to 0.5mm and the 

Stepdown to 1mm. 
 
• For the Small V-Bit 12mm 90degrees tool set the tool Stepover to 

0.1mm and the Stepdown to 5mm. 
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• Enter the Name Smart Engraving. 
 
• Select Calculate Now. 
 
• Close the form 

 
As always, The Toolpaths are listed in 
Toolpaths fly out panel. 
 
 

 
 
 
All of the 3 toolpaths created by the Smart 
Engraving options are displayed and could all 
be simulated at the same time. It would however 
be better to simulate them one at a time to see 
more clearly what each one is actually 
machining.   
 
 
 

 
 
 
 
End Mill 6mm tool 
This operation performs Area Clearance on 
the whole aperture to full depth (less than the 
Stepdown value). 
 
 
 
 

 
 

 
 
End Mill 3mm tool 
This operation performs Area Clearance on 
areas inaccessible to the larger End Mill. In the 
small enclosure at the tip the 1mm stepdown 
causes machining to occur at several Z 
descending Levels. 
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Small V-Bit 12mm 90degree tool 
With corner sharpening on, the tool will 
ramp along internal corner intersections to 
produce the sharpened and completed 
shape. 
 
 
 
 

 
 
• Select the 2D View and select the four triangular vectors and the text 

arc. 
 

 
 
 
 
As these are only small indentations only one V-Bit tool will be 
required. 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Smart Engraving  from the 2D Toolpaths Tab. 
• Enter a Start Depth of 0, a Finish Depth of 3mm and a Tolerance of 

0.01mm. 
• Select the Small V-Bit 6mm 90 degrees tool. 
• Change the Stepdown to 3mm. 
• Select Tool Clearance Strategy as Offset. 
• Select the option Do Corner Sharpening. 
• Select Calculate Now, followed by Close.  
 
Note: The name Smart Engraving 1 was automatically provided. 
 

18.4 Issue ArtCAM Pro 2010  



ArtCAM                                                                 18. Engraving
                                                          

 

• Select Simulate Toolpath.  
 

 
 
The small features and text have been 
machined using a single operation with 
the V-Bit tool. 
 
 
 
 
 
 
 

 

Machine Along Vector  
 

The Profile Toolpath option   also provides the option to directly trace along a selected 
vector, to a user defined depth. A typical application would to mark a scribe line around the 
outside of a component form.  
 
• Select the Outer vector as shown below. 
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• Select Create Profile Toolpath  from the 2D Toolpaths Tab. 
 

 
 
• Enter a Finish Depth of 1mm. 
 
• Select a Ball Nose 1.5 mm tool. 
 
• Enter a name Along vector BN3 
 
• Select Calculate Now. 
 
• Close the form. 
 
 
 
• Simulate the toolpath 
 
 
 
 
 
 
 

 
 

 
 
 
The outer limit of the component has 
been ‘scribed’ with the 1.5mm Ball 
Nosed tool. 
 
 
 
 
 

 
• Select File - Save As and enter as File Name SmartEngraving.art in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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19. Drilling  

Introduction 
 
In the 2D Toolpaths section there is a Drilling option, which uses selected vectors for 
defining the hole positions. The hole positions are defined either Central to circle vectors, at 
vector Node points, at a vector dimensional Centre, or on the Plunge Move positions of a 
selected 2D Toolpath.  
For creating a Drill tool the V-Bit tool page is used as this has the same geometrical shape. 
 
  
• Open the model Drilling.art from: D:\users\training\ArtCAM Data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the 6 Circle vectors. 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
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• Enter a Start Depth of 0, a Finish Depth 
of 20mm and a Plunge Clearance of 2mm. 
 
Plunge Clearance is a separate Safe Z for Drilling. 
 
• Set a Safe Z of 5mm and a Home 
Position of X0 Y0 Z5. 
• Select a Small V-Bit 6mm 90 degree tool. 
• Change the Tool Stepdown to 6mm. 
 
• Select the option Selected Circular 
Vectors. 
 
• Select Use Peck Drilling and enter a 
Retraction value of 4mm.  
The Drill will lift 4mm at each incremental Stepdown 
depth of 6mm. 
 
Optimise is one of several options controlling the order 
in which a hole pattern is Drilled. 
 
•  Define a Material Thickness of 25.4mm 
and set Z Zero at the top. 
• Enter Name as Name Drilling-1. 
• Select Calculate Now. 
• Select Close. 
 

 

• Select Simulate Toolpath.  
 

 
 
Note: To observe the 4mm upward 
Pecking movements at 6mm 
incremental depths, simulate at 
normal speed. 
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The Drill Centre of… All Selected Vectors will now be 
demonstrated. The drilled hole will be positioned dimensionally 
central to the selected vector. 
 
 
 
 
 
 
 
• In the 2D View select the oval vector. 
 
 
 
 
 
 
 
 
 
 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
 
• Enter a Start Depth of 0, Finish Depth of 6mm and a Plunge Clearance 
of 2mm. 
 
• Use the same Small V-Bit 6mm 90 degree tool. 
 
• Change the Tool Stepdown to 6mm. 
This means the drilling will be performed in a single peck. 
 
• Define Drill Centre of … as All Selected Vectors. 
 
• Enter as Name - Drilling-2. 
 
• Select Calculate Now. 
 
• Close the form. 
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• In the 2D View select the 5 Sided vector. 
 
 
 
 
 
 
 
 
 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
 
• Enter a Start Depth of 0, a Finish Depth of 10 and a Plunge Clearance 
of 2mm. 
• Use the same Small V-Bit 6mm 90 degree tool. 
 
• Define Drill Centre of… as All Selected Vector 
Nodes. 
 
• Enter as Name - Drilling-3. 
 
• Select Calculate Now. 
 
• Close the form. 
 
 
 
 
 
 
 
• Simulate the Toolpath.   
 
Observe the drill plunge directly to the 
full depth of 10mm, at the Node points of 
the 5 sided vector. 
 
 
 
 
 
• Select File - Save As and a enter a File name as Drilling Example in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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20. Projects  
Overview 
 
An ArtCAM project hosts any number of ArtCAM models, assemblies, and triangle mesh 
replicas. Each ArtCAM model within a project contains vector and bitmap artwork, reliefs 
and toolpaths. Each Assembly hosts triangle mesh replicas of ArtCAM models, material 
information, or further assemblies.  
 
A Project enables the user to perform such tasks as to re-orientate and reposition separate 
model items to put together a complete 3D Assembled Component. It is also possible to 
directly import Surface data (converted as a Triangle Mesh) into a Project as a separate 
Assembly item.  
 

Assembled Table Example 
 
 
• From the ArtCAM start up screen, select New Project. 
 
 
 

 
 

Project Tree 
Main Pull Down Menu 

3D View Toolbar 

Assembly Tools 
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Import of a Surface Model (Table Leg) 
 
 
 
• Right mouse click on the Assembly and select Import… 
 
 
 
• In the Import 3D Model dialog box, change the File of type to Surface 
Models and Open the File Table Leg.3dm from: D:\users\training\ArtCAM 
Data. 
 

 
 
 
ArtCAM has converted the .3dm surface model and placed it into the Assembly tree. 
 
 
 
 
 
 
The remaining Assembly components will be created within ArtCAM.  
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Creating the table top 
 
• In the Project Tree Right mouse click on Models, select New then Model. 
 

 
 

A new ArtCAM model will be created but also associated to this Project. 
 
 
• In the Size for New Model form enter the values as shown in the image 
below.  
• Select OK to proceed. 
 

 
 
 
 
 
 
 
 
• Create three Circles centred about X0 Y0 with 
respective Diameters of 750mm, 700mm and 
300mm. 
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• From the Reliefs top pull down menu, 
select Relief Clipart library. 

 
 

• From the Architectural Library, select Round Pattern 1. 
 
 
• Once the 3D Clipart dialog box and preview relief vectors are visible, 
close the Relief Clipart Library form. 
 
• Centre (in page) the preview Relief on the model using the F9 shortcut. 
 
 
 
• In the 3D Clipart form, set the following: 
 
 
• Apply a suitable Scale dynamically to the 
preview relief so that it is just within the outer 
circle vector (this will be a 2 stage process!). 
 
• Enter a new Z Range of 10 in the Size 
options. 
 
• Set the Mode to Add. 
 
• Select Paste and then Close. 
 
• From the 2D View, select the inner most circle vector, open the Shape 
Editor and select Zero to remove the inner part of the Relief form. 
 
 
 
• Select the Circle vector defining the inner 
edge of the table rim, and in the Shape Editor, 
select Zero Rest to remove the outside Relief 
form. 
 
 
• Select the outer circle vector and in the 
Shape Editor - Add a Plane Relief of Height 
20 over the whole of the existing table top. 
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• Select both the outer and inner rim circle vectors, and in the Shape 
Editor - Merge High with a Plane Relief of height 30 to produce the rim 
form. 
 
• Finally select the inner most circle vector and in the Shape Editor - 
Merge High with a Plane Relief of Height 30 to form the centre area. 
 
 

 
 
 
The next stage is to include this table top in the Assembly. 
 

• From the Model Toolbar, select Create Triangle Mesh.  
 
 
• Enter an Assembly name Table Top. 
 
• Select the option Close With a Flat Plane. 
 
• Select Create Triangles. 
 
The mesh is generated and shown in blue. It can be rotated to 
view the flat bottom. 
 
•  Select Add to Project. 
 
• Select OK and then Close the form. 
 
A mesh copy of the relief has been exported to the Assembly. 
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If not already visible, activate the Project fly out 
panel. 
 
The current Project status is summarised. 
 
  
 

 
 
 
 
 
 
 
 

 
 

 
 
• Under Models, Right mouse click on the (Untitled) 
model and Rename it to Top. 
 
To specify a Project name, it must be saved. 
 
• Select File - Save As and a enter a File name as 
Table Project in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs 
 
Note: A project is associated with a (*.3dp) file extension. When a project is opened, all 
associated ArtCAM models and Assemblies are opened with it. 
 
 
A new ArtCAM model will be created so the current model (named Top) will be closed. 
 
 
• Right mouse select on the model named Top and then Close. 
 
 
 
 
 
 
 
 
The current ArtCAM model is closed and so returns to the original Project window. 
 

Imported Table Leg (.3dm) 

Table Top mesh exported 
from ArtCAM model 

ArtCAM model 
(currently open and 
unnamed) 

Project Root folder (currently 
unnamed) 

20.6 Issue ArtCAM Pro 2010  



ArtCAM                                                                        20. Projects 

Creating the base 
 
 
• In the Project Tree Right mouse click on Models, select New then Model. 

 
A second new ArtCAM model will be created but again associated to this Project. 
 
• In the Size for New Model form enter the values as shown in the image 
below.  
 

 
 
 
• Select OK to proceed. 
 
• Create two Circle vectors about X0 Y0 with 
Diameters of 500mm and 200mm. 
 
 
 
 
 
 
• Select the outer circle vector and then Create 3D 
Blend  from the Relief creation Toolbar. 
 
• In the Profile options select Concave. 
 
• In 2nd Vector type in a value of 40. 
 
• Select Middle of Border Vector 
• Change the Proportion to 75%. 
 
• Select Add. 
 
• Select Create Blend followed by Close. 
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• View the results in the 3D view. 
 
 
Note: If the Project assembly is visible (table), then it can be switched off by selecting 

Toggle Assembly Visibility  or using Objects to Draw  from the 3D view tab. 
 
 
 

 
 
 
• Switch to the 2D view. 
 
• From the Reliefs top pull down menu, select Relief Clipart library. 

 
 

• From the Architectural Library, select Round Pattern 2. 
 
• Once the 3D Clipart dialog box and preview relief vectors are visible, 
close the Relief Clipart Library form. 
 
• Centre (in page) the preview Relief on the model using the F9 shortcut 
 
• In the 3D Clipart form, set the following: 
 
 
• Enter a suitable Scale dynamically to the preview 
Relief so that it is just within the outer circle vector 
(this will be a 2 stage process!). Select Apply. 
• Enter a new Z Range of 10 in the Size tab options, 
followed by Apply. 
• Set the Mode to Add. 
• Paste the preview Relief to the model. 
 

20.8 Issue ArtCAM Pro 2010  



ArtCAM                                                                        20. Projects 

 
 

 
 
 

• From the 3D view Toolbar, select Toggle vector visibility.  
 
• Select the inner most Circle vector, open the Shape Editor and select 
Zero to remove the inner part of the Relief form. 
 
 

              
 
 
 
 
 
 
 
• Select the outer most Circle vector, 
open the Shape Editor and Add a Plane of 
Height 20mm to the Relief form. 
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The next stage is to export this table base as a mesh to the Assembly. 
 

• From the Model Toolbar, select Create Triangle Mesh.  
 
 
• Enter an Assembly name Table base. 
 
• Select the option Close With a Flat Plane. 
 
• Select Create Triangles. 
 
The mesh is generated and shown in blue. It can be rotated 
to view the flat bottom. 
 
 
•  Select Add to Project. 
 
• Select OK and then close the form. 
 
 
 
 
 
 
• From the top menu, select File > Close Model. 
 
 
 
 
• Select Yes to Update the Project with your 
changes. 
 
 
 
 
The ArtCAM model is closed and reverts to the Project window.  
 
If nothing is visible, then the Assembly needs to be ‘shown’. 
 
 
• Right mouse select on the Assembly and 
select Show. 
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The full assembly is now shown. In the same way, individual meshes can be hidden or shown 
(using right mouse select).  
Note: The Table base is currently not shown as it is covered by the Table base.  
 
 
 
• Rename the second ArtCAM model to base as shown. 
 
 
 
 
 
• Select and highlight the Table Base mesh in the 
Assembly tree. 
 
 
 
 
This reveals further options that will apply only to the 
selected item (base). 
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• In the Positioning Tab, select Nudge.  
 
 
 
 
 
This form allows a selected assembly to be transformed and 
rotated in X, Y and Z directions. In this case, the base will be 
nudged in the Z direction to position it correctly at the bottom of 
the Leg. 
 
 
 
 
 
 
 

• In the Step field, enter a value of 630 and select the down arrow  to 
move the Base component into place. 
 
 

 
 
 
The assembly is now complete 
 
• Save (to update) and close the Project. 
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